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INTRODUCTION
Congratulations! You’ve purchased the most popular chess program for the personal
computer. Let CHESSMASTER 7000 amaze you with its teaching abilities and humble
you with its playing strength. Learn how you can customize CHESSMASTER 7000 to play
at whatever level you like, while keeping in mind that it’s best to challenge yourself to
your maximum potential. So get ready to combine your strength with CHESSMASTER

7000’s awesome teaching power! Whether you’re a loyal CHESSMASTER fan or a new
user, you’ll be amazed by this latest version.

The CHESSMASTER 7000 User’s Guide shows you how to get the most out of CHESSMASTER

7000. CHESSMASTER is rich with many exciting features and provides more functional-
ity than any other chess program available. Its unique power brings chess to life right
on your desktop, and the User’s Guide prepares you to enter that world.

This chapter:

• Outlines the system requirements.

• Shows you how to install CHESSMASTER 7000.

• Provides detailed information on how to get technical and customer support.

• Shows you how to login to CHESSMASTER 7000 and add new players.

System Requirements
To run CHESSMASTER 7000, you need the following:

• Pentium 150 (or higher) IBM PC or compatible running Windows® 95/98

• 24 MB RAM

• 4x CD-ROM drive (or higher)

• 20 MB of hard disk space

• Windows® 95/98 compatible sound card (16-bit recommended)

• Windows® 95/98 compatible pointing device

• SVGA video adapter and monitor capable of 800x600 resolution and 256 
colors (or higher)

• 28.8 Kbps modem for head-to-head play (28.8 Kbps or higher recommended)

• Internet access for CHESSMASTER LIVE

Installing CHESSMASTER 7000
You must use the setup program to install CHESSMASTER 7000. You cannot install it by
copying the software from the CD to your hard disk.

To install CHESSMASTER 7000

1. Insert Disc 1 in your CD-ROM drive. If you’re installing CHESSMASTER 7000 for the
first time, the CHESSMASTER 7000 Welcome screen appears. 

2. Click Install, and then click Next. Choose an installation option:

•Compact copies the fewest files to your. The setup program leaves the remain-
ing files on the CD for you to access as needed.

•Typical, the recommended option, copies all the program files to your system,
but leaves the audio files on the CD for you to access as needed. 

•Custom lets you specify the components you want to copy to your system. Select
the components you want, and then use the File Destination screen to make
sure you have sufficient disk space.

Copying these files to your system enhances performance when using certain features.
However, these files are always available on CD regardless of whether you copy them
to your hard drive:

3. Click Next and specify where you want to install CHESSMASTER 7000. The default
installation path is C:\Program Files\Chessmaster 7000. Click Browse to specify a
different path.

4. Click Next to begin the installation.

5. When the installation is complete, select Restart Windows, and then click Next.
(To run CHESSMASTER 7000, you must restart Windows“.)

6. Click Finish and Restart Windows Now.

Note: For more information on installing Mplayer.com for Chessmaster Live, see “Installing
the Mplayer Software” page 86 in chapter 9, “The CMLive Room.”

Technical Support
Whenever you contact the Technical Support Department, please include the following information or have it avail-
able if you are calling:
• Complete product title (including version number)

• Exact error message reported (if applicable) and a brief description of the problem you’re encountering

• Processor speed and manufacturer 

• Amount of RAM 

• Operating system

• Video card that you are using and amount of RAM it uses

• Maker and speed of your CD-ROM or DVD-ROM drive

• Type of sound card you are using



2. In the Player Name box, type your name.

3. Click Create. The CHESSMASTER 7000 lobby appears with seven icons, or “doors”,
that lead you into the seven CHESSMASTER rooms — the Library, Classroom,
Tournament Hall, Game Room, Database Room, Kids Room, and CMLive Room.

For detailed information on each
room, see their respective chapters in
this User’s Guide.

Note: When you create a player,
CHESSMASTER adds the name to the
Player Login dialog, so the next time you
start Chessmaster you can simply select
your name, and then click Login. Using
the above steps, you can add as many
players as you want to the Player Login
dialog. To delete a player, simply select
the player you want to delete from the
list, and then click Delete.

Viewing Player Information
For each player you add to the Player Login dialog, CHESSMASTER keeps a player pro-
file, which tracks the wins, losses, draws, overall rating, number of tutorials complet-
ed, number of games played in each room, and several other statistics.

To view the statistics for a given player

1. From the Player Login list, select the player whose information you want to view,
and then click View Player. The Player Profile for the selected player appears.

2. Click the appropriate tab to view the statistics you want.

Note: When you’re in a given room, you can view the profile of the current player. From the
Game Room, Classroom, Tournament Hall, Library, and CMLive, choose Player Statistics from
the Windows menu. From the Kids Room, choose Player Progress from the Windows menu.

Playing the Login Puzzle
CHESSMASTER 7000 introduces the new Login Puzzle on the Player Login dialog. Before
you log in to CHESSMASTER, you can challenge yourself right away by trying to solve
the “puzzle of the day!” With the Login Puzzle you never get bored, because a new
puzzle appears every time you start CHESSMASTER.

To use the Login Puzzle

1. Start CHESSMASTER to display the Player Login dialog.

2. Read the tip below the puzzle, and then attempt to solve it. CHESSMASTER lets you
know if the move you make is right or wrong.
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Contact us over the Internet
This is the best way to contact us. Our website is open 24 hours a day, 7 days a week and it contains the most up-
to-date Technical Support information available, including patches that can be downloaded free of charge. We
update the Support pages on a daily basis, so please check here first for solutions to your problems: http://sup-
port.ubi.com.
Contact us by phone
You can also contact us by phone by calling (919) 460-9778. Note that this number is for technical assistance only.
No hints or tips are given over the Technical Support line. When calling our Technical Support line, please make
sure you are in front of your computer and have all of the necessary information listed above at hand.
Be advised that our Technical Support Representatives are available to help you Monday – Friday from 9 am – 9
pm (Eastern Standard Time).
Contact us by standard mail  
If all else fails, you can write to us at:
Ubi Soft Technical Support
3200 Gateway Centre Blvd., Suite 100
Morrisville, NC 27560
Return policy
Please do not send any game returns directly to Ubi Soft Entertainment. It is our policy that game returns must be
dealt with by the retailer or online site where you purchased the product.  If you have a damaged or scratched CD,
please visit our FAQ listing for your game and get the latest replacement policy and pricing.

Starting CHESSMASTER 7000
If Disc 1 is currently in your CD-ROM drive, choose Programs>Chessmaster
7000>Chessmaster 7000 from the Windows Start menu.

If Disc 1 isn’t in your CD-ROM drive, insert it to display the CHESSMASTER 7000
Welcome screen, and then do one of the following:

• Click Run to start CHESSMASTER 7000.

• Click Uninstall to remove CHESSMASTER 7000 from your system.

• Click Cancel to exit CHESSMASTER 7000.

Getting Started
When you start Chessmaster 7000,
the Introduction video plays. 
You can watch the video or skip 
it by pressing Esc or clicking 
inside the video window. When 
the video stops, the Player Login
dialog appears.

To start using CHESSMASTER 7000, you must login as a player.

To log in as a player

1. Click New Player on the Player Login dialog. The Create New Player dialog appears.



To design the layout of the playing area

1. From the Preferences menu, choose 
Chess Set. The Select Chess Pieces 
and Board dialog appears.

2. Select the chessboard you want from 
the top and the pieces from the 
bottom, and then click OK. 
CHESSMASTER displays the chess set 
you selected.

3. Click anywhere on the border 
(or frame) of the chessboard, and 
then drag it to the location you want.

4. From the Windows menu, select the windows you want to display in the playing
area. A chess piece symbol next to the menu option indicates the corresponding
window is open.

CHESSMASTER saves the current layout of your playing area until you customize it again
or replace it by opening an existing layout.

Note: For more detailed information on the CHESSMASTER 7000 windows, see “Using the
CHESSMASTER Windows” on page 9.

Opening and Saving Playing Area Layouts

CHESSMASTER 7000 makes it easy to save the current layout of your playing area, so
you can use it again later.

To save the current layout

1. From the Preferences menu, choose Layouts. The Layouts dialog appears. 

2. Click the Save tab, and then specify where you want to save the layout. The default
path is C:\Program Files\Chessmaster 7000\Layout.

3. In the File Name box, type a name for the layout, and then click Save. CHESSMASTER

automatically appends the .lay extension to all layout files.

To open an existing layout

1. From the Preferences menu, choose Layouts. The Layouts dialog appears. 

2. Click the Open tab, and then open the folder that contains the layout you want.
The default path is C:\Program Files\Chessmaster 7000\Layout.

3. Double-click the layout you want, and then click Load. CHESSMASTER opens the
playing area layout you selected.
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3. If you can’t figure it out, simply click I Give Up. CHESSMASTER highlights the correct
move for you.14p

DEFINING YOUR ROOM ENVIRONMENT
CHESSMASTER 7000 categorizes its many powerful features into seven different rooms
æ Library, Classroom, Tournament Hall, Game Room, Database Room, Kids Room,
and CMLive. For detailed information on what you can do in each room, see their
respective chapters in this User’s Guide.

Each CHESSMASTER room provides a set of features that lets you design the room envi-
ronment to suit your needs and tastes. Depending on which room you’re in, setting
up the environment can involve one or more of the following:

• Designing the layout of your playing area, which includes selecting a chess set,
defining its position, and displaying one or more of the CHESSMASTER windows.

• Setting up sounds, narrated features, and window and CMLive effects. For example,
you can activate sound narration, so that you can listen to CHESSMASTER’S
advice while you’re playing a game, and you can tell CHESSMASTER to notify you
when someone from CHESSMASTER LIVE logs on, sends you a message, or challenges
you to a game.

• Configuring your chessboard, which includes specifying certain settings, such as
turning the board lights on or off, determining the speed at which the chess pieces
move, deciding whether you want CHESSMASTER to let you know the openings that
you and your opponent are using, and so on.

• Specifying the type of chess notation you want to use. Chess notation refers to the
codes that represent individual moves on the chessboard.

Designing Your Playing Area Layout
The playing area layout consists of the chess set, the chessboard position, and the
CHESSMASTER 7000 windows that appear in a given room. For example, in the Game
Room, you might want a 3D Blue Marble chessboard with Art Deco pieces, and the
Player Profile, Captured Pieces, and Game Status windows open. However, in the Kids
Room, you might want a 2D Kids chessboard with Kid’s Clay pieces and the Shortcuts
and Chess Coach windows open.

You can design the layout of the playing area using certain features in CHESSMASTER.
You can use also use one of the pre-defined layouts that CHESSMASTER provides. If you
choose to design your own custom layout, you can save it to a file, and then use it
again later, or open it in another room at any time. For more information on opening
and saving layouts, see page 6.



Using the Custom Board

In addition to the Vector Board described above, Chessmaster provides a Custom
Board that you can design and customize before you display it in the playing area. You
can set its size, orientation, perspective (2D or 3D), and rotational angle; specify the
starting location of the white pieces; and define the colors of the light and dark
squares on the board.

To use the Custom Board

1. From the Preferences menu, choose Chess Set. The Select Chess Pieces & Board
dialog appears.

2. Scroll through the Board list (at the top), and then select Custom Board. The
Customize button becomes active.

3. Click Customize to display the Custom Board dialog. A chessboard prototype also
appears, so you can see the effects as you choose the settings in the dialog.

4. Use the Turn scroll bar to set 
the rotational angle of the 
chessboard.

5. Click 2D or 3D to specify 
whether you want your board 
to be flat or have perspective. 
The Tilt scroll bar lets you set 
the board anywhere between

2D and 3D. If you choose 3D, you can use the View scroll bar and the Shallow,
Normal, and Deep buttons to modify the perspective further. Shallow makes the
board appear closer, Normal restores the default view, and Deep makes the board
appear farther away.

6. Use the Size scroll bar or the Tiny, Medium, and Full Size buttons to set the size of
the board. Tiny sets the board to its smallest size, Medium sets it to its default size,
and Full Size sets it to fill the entire window. The scroll bar lets you size the board
anywhere between Tiny and Full Size.

7. Use the Left, Top, Right, and Bottom buttons to specify where you want the white
pieces to appear on the chessboard. The black pieces will always appear on the
opposite side you specify.

8. Click Colors to display the Chess Board Colors dialog, and define the colors for the
light and dark squares on the board. (Use the same steps in the Vector Board pro-
cedure described above.)

9. Click OK to close the Customize Board dialog, and then click OK again to display
your Custom Board in the playing area.

Note: Unlike the Vector Board, you can’t size the Custom Board after you display it in the
playing area. To resize it, use the Customize Board dialog.
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Selecting a Chess Set

Perhaps the most important item that contributes to your enjoyment in the game of
chess is the actual chess set. Over the centuries, the game of chess has continued to
inspire artists around the world, and the world considers some of the chess sets they
designed as exquisite works of art. The most classic of these is the Staunton style, of
which CHESSMASTER provides many different versions.

CHESSMASTER provides a diverse set of chessboards and chess pieces to choose from—
including a wide variety of 2D and 3D sets. Two-dimensional chess sets are flat, and
three-dimensional chess sets have perspective.

CHESSMASTER makes it easy to select the chess set you want. Simply choose Chess 
Set from the Preferences menu, select the chessboard you want from the top and 
the pieces from the bottom, and then click OK. CHESSMASTER displays the chess 
set you selected.

If you want to use a chess set that you can resize or customize, select the Vector Board
or the Custom Board at the bottom of the board list in the Chess Set dialog. The
Vector Board is described next, and the Custom Board is described on page 8.

Using the Vector Board

CHESSMASTER 7000 provides a 2D Vector Board that you can resize in the playing area
without going through any special steps in a dialog. You can also use the corre-
sponding Vector Board Colors dialog to change the colors of the Vector Board squares.

To use the Vector Board

1. From the Preferences menu, choose Chess Set. The Select Chess Pieces & Board
dialog appears.

2. Scroll through the Board list (at the top), and then select Vector Board. The
Customize button becomes active.

3. Click Customize to display the 
Vector Board Colors dialog.

4. Click Light Squares, and then use 
the Blue, Green, and Red boxes to 
set the color for the light squares. 
Type the value you want in each 
box, or use the up and down 
arrows to increase and decrease 
the value accordingly.

5. Repeat step 4 to set the color for the dark squares, and then click OK. 

6. Click OK again to close the Select Chess Pieces & Board dialog. CHESSMASTER dis-
plays the Vector Board using the colors you defined.

7. Resize and move the Vector Board in the same way you resize any window.



Game Status Window

The Game Status window displays the names of the play-
ers and their ratings, the elapsed time for each player, the
Move List (which lists each moves in the game), and VCR
buttons that let you scroll through each move in the game.
Moves are displayed in the current notation. You might
want to open the Captured Pieces window as you scroll
through each move.

The Game Status window is useful for games in progress and
for analyzing and studying saved games, particularly the
Classic Games. This window is not available in the Classroom.

Annotation Window

The Annotation window lets you review CHESSMASTER’S
comments on a given move and review its analysis of the
overall game after you play it. It also lets you enter your

own comments on a given move while you’re playing the game. Use this window in
conjunction with the Game Status window described above.

The Annotation window contains three tabs:

• The Player tab lets you enter 
comments and analytical information 
on the moves you make during a game. 
Simply click the Edit button, type the 
information you want in the edit box, 
and then click OK.

• The Auto Annotation tab lets you play 
CHESSMASTER’S overall analysis of your 
game after you finish playing it. You 
can also use it to listen to the analysis 
of a saved game. To use Auto 
Annotation, you must first select Game 
Analysis from the Mentor menu. Then

click Play on the Auto Annotation tab and listen to CHESSMASTER provide commen-
tary on the current game, focusing on tactical and strategic points, as well as possi-
ble variations on certain moves. When you click Play, it changes to Pause. Click
Pause to pause the analysis, and then click Play again to resume the analysis. Click
Stop to stop the analysis and to rewind the analysis to the beginning.

• The Analysis tab provides text-based analysis on the current board position, includ-
ing a numerical score and the best line of moves. Use the VCR buttons on the Game
Status window to scroll through and review the analysis of different moves and game
board positions.

Note: Because you use the Annotation window to enhance your playing skills and to study
existing games, it is accessible only in the Game Room and the Library.
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Using the CHESSMASTER Windows

All the CHESSMASTER rooms — except the Database Room — provide several visual
aids that you can use while you play, practice, or learn chess. You can access these
visual aids (also called “windows”) from the Windows menu.

This section describes the available CHESSMASTER windows. Note that some of the win-
dows are not accessible in certain rooms, simply because they don’t apply. For exam-
ple, the Annotation window, which contains comments and analytical information on
the current game, is not available in the Tournament Hall, because when you’re play-
ing a tournament, you’re not supposed to have access to such information.

Note: Windows that are specific to a given room are described in their respective chapters
later in this User’s Guide. For example, the Chat window and Online Information 
window, which are accessible only in the CMLive Room, are described in chapter 9, “The
CMLive Room.”

Shortcuts Window

The Shortcuts window contains shortcuts to the commonly used features in the cor-
responding room. For example, the Shortcuts window in the Game Room contains
shortcuts to the New Game, Move Advice, Setup Game, and Game Analysis features.
These features are popular in this room, because when you’re sharpening your game
skills, you’ll want to start or setup a new game often and have quick access to
CHESSMASTER’S analytical information.

In the Kids Room, the Shortcuts
window contains shortcuts to
popular features among kids, such
as, selecting a new chess set, 
setting up a game, viewing your
progress, or listening to and 
learning from International
Chessmaster, Josh Waitzkin.

Every room (except the Database Room) has a corresponding Shortcuts window that
contains its own unique set of shortcuts.



To select a sound for piece movements

1. From the Preferences menu, choose Sound.

2. Display the Piece Movement tab.

3. Select the sound you want, and then click OK.

Note: For instruction on choosing your own piece sounds, see CHESSMASTER 7000 help.

Activating Narrated Features

CHESSMASTER 7000 provides a variety of narrated features, which you can activate or
deactivate from the Voice tab in the CHESSMASTER Sounds dialog. You can activate one
or more of the following narrated features:

• Auto-Annotation, which produces voice narration to accompany what’s currently
being displayed in the Game Status and Annotation windows. The voice provides
commentary on individual moves and game analysis; in other words, it narrates the
annotations in those windows. 

• Natural Language Advice, which produces narrated advice for your next move during
the entire game.

• Tutorials#, which produces narrated help as you’re working through the tutorials
that CHESSMASTER provides.

• Illegal Move Commentary#, which produces narrated commentary whenever you
make a wrong or illegal move. In addition to letting you know when you make an
illegal move, CHESSMASTER also lets you know why.

To activate or deactivate the narrated features

1. From the Preferences menu, choose Sound.

2. Click the Voice tab.

3. Check the narrated features you want on, clear the narrated features you want off,
and then click OK.

Activating Window and CMLive Effects

If you’re connected to the Internet and spend time in the CMLive (CHESSMASTER LIVE)
room, then you can take advantage of the sounds that CHESSMASTER plays when some-
one from CHESSMASTER LIVE logs on, sends you a message, or challenges you to a game.
These sounds, as well as the sound that plays whenever you close CHESSMASTER, are
on by default. You can access them and turn them off from the Effects tab in the
CHESSMASTER Sounds dialog:

• Window Close produces a sound whenever you close the CHESSMASTER window 
or exit. 

• Buddy Login produces a sound and a message whenever someone from CHESSMASTER

LIVE logs on.
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Captured Pieces Window

The Captured Pieces window displays the captured pieces on both sides as the game
progresses. You can resize the window as necessary to show all the captured pieces.

You can use Captured Pieces window to help you track your progress. You can also
use it in conjunction with the Game Status window (described earlier) to study saved
games. This window is not available in the Classroom and Database Room.

Player Statistics/Player Progress Window

The Player Statistics window displays a profile on the current player, as well as the
wins, losses, draws, overall rating, number of tutorials completed, number of games
played in each room, and several other statistics. In the Kids Room, this window is
called the Player Progress window.

You can also view the Player Statistics of different players from the Player Login 
dialog, which appears when you first start CHESSMASTER.

Setting Up Sounds, Voice, and Effects
CHESSMASTER 7000 provides a wide range of audio features that you can control. Every
room provides a CHESSMASTER Sounds dialog that lets you control certain sound
effects, such as the sound the chess pieces make when you move them on the board
or capture another piece; whether or not certain features are narrated; and whether or
not CHESSMASTER notifies you when someone from CHESSMASTER LIVE (playing chess on
the Internet) logs in, sends you a message, or challenges you to a game.

Selecting a Sound for Piece Movement

The sound your pieces make when you move them on the board or capture another
piece depends on the option you select from the Piece Movement tab in the CHESSMASTER

Sounds dialog. You can choose one of the following piece movement sounds:

• Spoken Move Announcements, which produces spoken commentary for all moves
made on the chessboard. This is the default option. 

• Thematic Sound Sets, which produces a sound related to the theme of the chess set
you’re using. For example, if you’re using the Napoleon chess set, the sounds are
marching feet; if you’re using the Chinese chess set, the sounds are oriental in nature;
and so on. Note that not all chess sets have a thematic sound associated with it.

• Simple Sounds, which produces a simple “clinking” sound found in many Windows
applications.

• No Sounds, which turns sound off altogether for piece movement. If you need a quiet
environment to concentrate and you’re most comfortable playing chess in silence,
select this option.



• Announce Check and Announce Openings determine whether CHESSMASTER lets you
know when you’re in check and what opening lines you and your opponent are
using (when you make enough moves to identify a line). When these options are on
(the default), CHESSMASTER displays the respective messages when appropriate in the
status bar, at the lower-left of the room window.

• Time Stamp Annotation determines whether CHESSMASTER adds the elapsed time for
each move into the Analysis tab of the Annotation window. The time is taken from
the elapsed time indicated on the Game Status window. This option is on by default.

• Highlight Move Squares determines whether CHESSMASTER reiterates each move that
your opponent makes, by highlighting the original square, and then destination
square, after your opponent makes each move. This option is off by default.

• Sliding Pieces is one of two ways in which CHESSMASTER lets you control how pieces
move on the board. (The other is Quick Entry described above.) Sliding Pieces refers
to the animation speed at which your opponent’s pieces move. This option is on by
default at a Fast pace, which causes your opponent’s pieces to move across the board
quickly. If you click Off, your opponent’s pieces snap to their destination. If you
click Slow, your opponent’s pieces slide slowly to their destination squares. 

• Board Coordinates determines whether your chessboard displays coordinates, and if it
does, how CHESSMASTER displays them. Coordinates are helpful when you use coor-
dinate notation. Board Coordinates on are by default in Rank & File format. In this
format, the horizontal rows are labeled 1 through 8, and the vertical rows are labeled
a through h. If you click In-Square, CHESSMASTER displays the corresponding Rank &
File coordinate in each square, so you don’t have to figure them out on your own.

Flipping Your Chessboard

By default, the white pieces are on the bottom of the chessboard (the side closest to
you), and the black pieces are on the top. At any time, you can flip the chessboard so
that the white and black pieces swap sides.

To flip your chessboard

• From the Preferences menu (or the right-click menu), choose Flip Board.

This feature is useful when you’re analyzing an existing game, and you want flip the
board to view the perspective of the other player. It’s also useful in the Game Room
when you’re playing against yourself, and you want to flip the board to see the next
move from the perspective of the opposing side.

Note: If you’re using the Custom Board, you can also use the Customize Board dialog
(described on page 8) to change the location of the white and black pieces.
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• Tell Chat produces a sound and a message whenever someone from CHESSMASTER LIVE

sends you a message.

• Game Challenge produces a sound and a message whenever someone from
CHESSMASTER LIVE wants to challenge you to a game in the CMLive Room.

To turn the window and CMLive sounds on and off

1. From the Preferences menu, choose Sound.

2. Click the Effects tab.

3. Check the sounds you want on, clear the sounds you want off, and then click OK.

Configuring Your Chessboard
After you select the chess set you want, you can configure your chessboard using the
board settings that CHESSMASTER provides. Each room (except the Classroom and
Database Room) comes with a Board Settings dialog that lets you configure your
chessboard to work the way you want.

To configure your chessboard

1. From the Preferences menu, choose 
Board Settings. The Board Settings 
dialog appears.

2. Use the check boxes and radio buttons 
to specify the board settings you want. 
(The options are described in detail 
below.) Check marks and highlighted 
radio buttons indicate that the corres-
ponding settings are on.

3. Click OK to apply the selected settings to 
your chessboard.

Using the Board Settings Dialog

The options on the Board Settings dialog are described below:

• Board Turn Lights determines whether the turn lights on your chessboard are on or
off. Turns lights, which appear on the right side of the chessboard, indicate whether
it is White or Black’s turn to move. The turn lights are on by default.

• Quick Entry is one of two ways in which CHESSMASTER lets you control how pieces
move on the board. (The other is Sliding Pieces described below.) Quick Entry lets
you move a chess piece by clicking its destination square, rather than dragging and
dropping it. When Quick entry is active, and you click a piece that has exactly one
legal move, that move is made. If you click a square to which only one piece can
move, that move is made. Quick Entry is off by default.



Bb5 ........ White attacks by moving the Bishop to b5

a6 .......... Black threatens that Bishop by moving the Pawn from a7 to a6

Ba4 ........ White moves the Bishop out of harm’s way

Nf6 ........ Black takes this opportunity to develop the other Knight

If you’re capturing a piece, indicate the piece that is doing the capturing, followed by
a x for capture, followed by the square of the piece you are capturing. For example: 

Bxc6 ...... White Bishop captures the Black Knight on square c6

dxc6 ...... When a Pawn makes a capture, indicate the file on which it starts; the 
Pawn started on the d-file

d3 .......... Returning to the game, White moves the d-Pawn one square forward

Check .... Black responds by checking with the Bishop

Bb4+ ...... When a move places the other side in check, use a + at the end

Sometimes, identical pieces can move to the same square. For example, White can
remove the threat to the King by moving a Knight to d2. Unfortunately, Nd2 doesn’t
tell you which White Knight moved. (Knight on f3 or the Knight on b1.)

When identical pieces can move to the same square, do the following 
algebraic notation:

• If both pieces start on the same file, put the starting rank (1 - 8) right after the name
of the piece. Otherwise, put the starting file (a - h) right after the name of the piece.
In this case, the two White Knights are on different files. So you would write Nfd2
(starting file after the piece name).

• If you are castling King-side, write O-O. If you are castling Queen-side, write 
O-O-O.

• If you are promoting a Pawn, write the letter of the new piece at the end of the move;
for example, e8Q+ (the new Queen checks the Black King) KC7.

• When a move causes checkmate, add an extra plus sign (+)at the end of it; for 
example, Rh7++.

For Pawn promotions, the first two digits represent the starting square of the Pawn.
The third digit is the destination file (1-8). The fourth digit represents the new piece
— 1 for Queen, 2 for Rook, 3 for Bishop, and 4 for Knight. In this position, interna-
tional notation records White’s mating move (b7xc8N++) as 2734.

Note: For detailed information on other notation types see the CHESSMASTER 7000 Help.
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Specifying Chess Notation
Chess notation refers to the codes that represent individual moves on the chessboard.
When you move a chess piece, CHESSMASTER records the move in chess notation,
which you can view in the Game Status and Annotation windows.

Note: In addition to moving pieces with the mouse, you can also move your pieces by typing
the moves in chess notation on your keyboard, and then pressing Enter. For more informa-
tion on moving pieces using chess notation, see “Moving Pieces” on page 25.

In every room (except the Kids Room), CHESSMASTER provides six types of chess nota-
tion from which you can choose — Coordinate, Algebraic, Long Algebraic, Figurine
Algebraic, Descriptive, and International.

To select a chess notation

• From the Preferences menu, choose Notation, and then from the cascading menu,
choose the type you want. The Notation types are described in more detail in the
pages that follow.

Algebraic Notation

Algebraic Notation is the generally accepted method of recording moves in a chess
game. Moves combine symbols for the piece and its destination square. Major pieces
are uppercase letters (K, Q, B, N, R), Pawns are rank and file, files are letters a through
h, and ranks are number 1 through 8. Given this, consider the following example:

Be5 is Bishop to file e, rank 5, and e5 is Pawn to file e, rank 5. 

Algebraic notation records captures with an x (for example, Bxe5), checks with a plus
sign (+), checkmates with a double plus sign (++), castling King-side with a O-O, and
castling Queen-side with a O-O-O.

To describe a move in algebraic notation, first indicate the letter of the piece that is
moving — K for a King, Q for a Queen, R for a Rook, B for a Bishop, and N for a
Knight. If you’re moving a Pawn, indicate the file (a - h) and rank (1 - 8) of the piece’s
destination square. For example, the notation for the first few moves of a game might
look like this:

e4 .......... White opens by moving the Pawn to square e4 

e5 .......... Black responds by moving the Pawn to square e5

Nf3 ........ White moves the Knight to square f3

Nc6 ........ Black moves the Knight to square c6



Choosing an Opponent

CHESSMASTER 7000 offers a gallery of oppo-
nents from which you can choose — each
with a photograph, biography, and distinct
playing style. The gallery, which is made
up of over 100 different personalities,
including 80+ human-like players, 38
grandmasters, and the CHESSMASTER. You
can also play against a real player or a cus-
tom personality that you create yourself.
For information on how to create a custom
personality, see “Creating a Custom
Personality” on page 19.

To choose an opponent for an unrated game

1. From the Game menu, choose Set Up Game. The Setup Game Details dialog
appears displaying the players above and below the chessboard. By default, you are
white (on bottom), and your opponent is black (on top).

2. Click the Computer button next to the Top opponent box, and then click
Personality. The Select Personality dialog appears.

3. Scroll through the list to view the
available personalities. Use the Filters 
tab to specify the criteria you want 
your opponent to meet and to filter the 
list accordingly. Use the Info tab to 
view the biography and playing style of 
the current opponent.

4. Select the opponent you want to play, 
then click OK. The name of the 
opponent you selected appears in Top 
opponent box of the Setup Game 
Details dialog.

5. Click OK to close the Setup Game Details dialog.

You can also play a human player. For example, you might want to play your room-
mate, your colleague, your friend, your sibling, your parent, etc.

To specify a human player as your opponent

1. From the Game menu, choose Game Details. The Setup Game Details dialog
appears displaying the players above and below the chessboard. By default, you are
white (on bottom), and your opponent is black (on top).

2. Click the Human button next to the Top opponent box.

3. Type the name of your opponent in the opponent box and click OK.
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THE GAME ROOM
Welcome to the CHESSMASTER 7000 Game Room. The Game Room, also known as the
“skittles” room, is the place where you can experiment, relax, and have fun. You can
play unrated practice games to test your skills and to work on the different elements
of your game. You can use CHESSMASTER’s sharp mind and expertise to gain invaluable
advice on individual moves, and you can take advantage of its analytical abilities to
learn how to play a given game even better.

But that’s not all! In the Game Room, you can also set up your chessboard to look and
work in a way that suits you best, tell CHESSMASTER to solve for mate, play out differ-
ent openings, and use any one of the available coaching options. During a game, you
can do things like switch sides with your opponent, force your opponent to move,
and take back and replay moves. You can also pause, adjourn, resign from a game, or
offer a draw at anytime. In the Game Room, the possibilities are endless, so sit back,
relax, and play freely at your own pace!

Important: Before you play in the Game Room, it’s important you review chapter 2, “Defining
Your Room Environment” on page 5. Chapter 2 shows you how to set up a room to suit your
needs and tastes, thereby allowing yourself to get the most out of Chessmaster. By reviewing
it, you’ll learn how to design the layout of your playing area; set up sounds, narrated features,
configure your chessboard; and specify the type of chess notation you want to use.

Playing an Unrated Game
After you set up your room environment, using the information in chapter 2, you’re
ready to specify the details of your game. Because the primary purpose of the Game
Room is to enhance your chess skills and practice your moves, you can play only
unrated games in the Game Room.

In the Game Room, CHESSMASTER provides a Setup Game Details dialog that lets 
you specify the game settings for an unrated game. You can use the options in 
this dialog to:

• Choose your opponent by selecting one of the CHESSMASTER computer personalities,
creating a computer personality of your own, or specifying a human player, such as
your friend or co-worker.

• Select a time control, which determines how much time is given for individual
moves and/or the entire game.

• Specify your chess piece color and the side on which you want to play.

• Set the rules of the game, which include Touching and Blindfold Play.



CHESSMASTER automatically saves new personalities as .cmx files in the Chessmaster
7000\Personalities folder. If you want your personality to appear in the opponent
gallery, you must save it to this folder.

7. Choose OK to assign the new personality as your opponent in the current game.
Note that OK does not permanently save the personality. You must click Save to
save the new personality to file that you can access later.

Note: To delete a custom personality, display in the Edit Personality dialog, and then click
Delete. Note that you can’t delete the existing personalities that Chessmaster provides.

Style Options
On the Edit Personality dialog, use the Style tab options to specify the playing style
for the personality you’re creating:

• Attacker/Defender sets the personality’s tendency to capture pieces, ranging from -100 to
100. Negative values emphasize attack; positive values emphasize defense. 0 represents
a balance. An attacker tries to capture pieces and reduce their numbers as much as pos-
sible. A defender tends to do the opposite, which is to avoid exchanges where it can.

• Strength of Play determines the quality of your opponent’s play. A rank novice has
strength of play at or near 0. A grandmaster has strength of play exceeding 100. Set
the scroll bar low for a weak player, or higher for a greater challenge.

• Randomness adjusts the personality’s diversity of play, while maintaining its strength
of play. If set at 0, the personality makes the same moves every time. (All other
adjustments remain the same.) A higher setting causes the personality to play with
increasing diversity, making the personality more fun to play.

• Book Search Depth sets the number of moves the personality looks at or refers to in
the opening lines of its corresponding opening book. The purpose of the opening
book is to assist the personality in making a strong opening, thus basing its game on
a sound foundation and developing a weakness in its opponent from the start. If the
opening lines (in the book) contain more moves than the number you specify, the
personality will ignore the remaining subsequent moves in each line. A high setting
causes the personality to look deep into the opening lines, thereby increasing its
chances of finding a strong move. A low setting causes the personality to look at
only a few moves, thereby lowering its chances of finding a strong move.

• Max Search Depth sets the number of future moves at which the personality looks
ahead. A high setting causes the personality to look far ahead, thereby increasing its
chances of improving its strategy. A low setting causes the personality to look ahead
at only a few moves, thereby lowering its chances of improving its strategy.

• Selective Search determines how sensitive the personality is to non-useful plies,
when analyzing the possible positions in a game. It sets the number of plies (from
1 to 10) that the personality looks at before making its next move. Unless told to do
otherwise, the personality considers all possible plies (which can be infinite in num-
ber) before making its next move. This makes for slow playing by the personality.
The default is 6, which means the personality selectively disregards unpromising
lines for the first six plies of the search. Beyond the selective search, it does a brute-
force search of all possible remaining moves.
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Creating a Custom Personality

In addition to specifying a human player or choosing from the personalities that
CHESSMASTER provides, you can create your own opponent by opening an existing per-
sonality, customizing its playing attributes, and then saving it as a new personality.
After you create a new personality, you can then choose it as your opponent using the
same steps you use to choose an existing personality. For more information, see
“Choosing an Opponent” on page 52.

Note: You can choose a custom personality as your opponent only when you’re playing an
unrated game.

To create a custom personality

1. From the Game menu, choose Set Up Personality. The Edit Personality dialog appears.

2. Click the “…” button next to the
Personality box. The File Open 
dialog appears. (CHESSMASTER

stores its existing personalities as 
.cmx files in the CHESSMASTER

7000\Personalities folder.)

3. Select the personality that you 
want to use as a base for your 
custom personality, and then click 
Load. The personality you selected
appears in the Edit Personality 
dialog along with its correspond-
ing playing attributes.

4. In the Personality box, type a name for the new personality. (If you use the same name
as the existing personality, CHESSMASTER automatically appends a number to the end
of the name when you save it to avoid overwriting the existing personality.)

5. Click the “…” button next to Opening Book to display the File Open dialog, and
then select the opening book that you want to assign the selected personality.
(CHESSMASTER stores its opening books as .obk files in the Chessmaster
7000\Opening Books folder.)

Note: An opening book is a series of opening moves and counter moves that have been thor-
oughly analyzed. Each Chessmaster personality has an opening book associated with it — a
repertoire or mini database of known opening lines. (An opening line can contain one or more
moves.) The purpose of the opening book is to assist you in making a strong opening, thus
basing your game on a sound foundation and developing a weakness in your opponent from
the start. For more on opening books, see chapter 6, “The Library”.

6. Edit the Style, Positional, and Material attributes you want, and then click Save to
create the new personality. For detailed information on each tab and their respec-
tive options, see the following subsections.



Material Options

On the Edit Personality dialog, use the Material tab options to determine the 
importance the personality places on its own chess pieces and those of its opponent.
The possible values for each piece are between 0.0 (no importance) to 10.0 
(highest importance).

The default material points for chess pieces are:

Queen =  9

Rook =  5

Bishop =  3

Knight =  3

Pawn =  1

Selecting a Time Control

The amount of time you give yourself and your opponent to complete a game (or a
move) is one of the most important factors in enjoying a game to its fullest. If you like
to play quickly, you should be aware that CHESSMASTER, like all other chess programs,
is very strong at quick chess. Indeed, within its search parameters, it is almost perfect.
However, it is not nearly as strong positionally. Humans have a much better chance
beating it with slower time controls because the ability to plan weighs more heavily.

Virtually all competitive chess and most offhand chess are timed by two special clocks
placed by the side of the board and running in tandem. These clocks are designed so
that one clock times one player, while the other clock times the other player. When a
player is done thinking about a move, the player makes the move and toggles the
clock so that his or her opponent’s clock starts and the player’s own clock stops.
During a game, one clock is always running.

International chess is timed at the rate of 40 moves in 120 minutes for each player,
with another 20 moves to be made in an additional 60 minutes for each player, if nec-
essary. If the game is still going after 60 moves and 6 hours, players are allotted a final
60 minutes each to complete the game. In such a game, players are free to allot their
time in any way they see fit. They must complete the required number of moves at
each control point, but other than that, they are completely free. In fact, they can use
all or almost all of their time on one move. 

In the famous Moscow International Chess Tournament of 1967, the East German
Grandmaster Wolfgang Uhlmann used an hour and 50 minutes for one move, leaving
himself only minutes to complete the rest of the game. If either player uses up all of
his or her time before completing the required number of moves, he or she is forfeit-
ed immediately. (As you will see, CHESSMASTER is somewhat more forgiving.) So, 
players who have used too much time in the early stages of their games have to make
the rest of their moves very quickly. They are under what is known as time-pressure
and tend to become frantic as they try to complete their required number of moves.
Uhlmann’s long think did him precious little good: he lost to Tal in very few 
additional moves.
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• Contempt for Draw determines how the personality reacts when you offer a draw. If
set at 0, the personality accepts an offer to draw if the game is even. If set at 1, and
it’s behind by less than a pawn (1 point), it rejects the draw. If set a –2, and the per-
sonality is less than 2 points ahead, it accepts the draw. 

• Transposition Table speeds up the personality’s thinking and strengthens its play by
allowing it to skip move it has already analyzed. A check mark indicates that this
option is on (the default).

• Deep Thinking lets the personality think about its subsequent moves while your time
is elapsing, which is much to its advantage. A check mark indicates that this option
is on (the default). To weaken the personality’s play, clear this option.

Positional Options

On the Edit Personality dialog, use the Positional tab options to determine the impor-
tance the personality places on the position of the chess pieces on the board:

• Material/Position determines whether the personality values material points of pieces
on the chessboard; the overall positional attributes, such as pawn structure, attack
potential, piece mobility, forks, and so on; or a balance of both. When computer
personalities (and real players) evaluate a chess position, they consider both. The
range for this option is -100 to 100. Negative values emphasize material, positive
values emphasize positional, and 0 represents a balance of both.

• Control of Center sets how much the personality values controlling the center of the
board, especially the d4, d5, e4, and e5 squares, from both attack and defense per-
spectives. The higher the setting, the more important control is to the personality.

• Mobility sets how much the personality values placing its pieces to keep open a max-
imum number of move opportunities. The higher the setting, the more important
mobility is to the personality.

• King Safety sets how much the personality values keeping the king safe, or free from
attack, as opposed to being comfortable with a certain amount of pressure if it frees
other pieces from having to guard him. The higher the setting, the more the per-
sonality tries to keep the king safe.

• Passed Pawns sets how much the personality values developing passed pawns as
opposed to other tactics. The higher the setting, the more the personality wants to
develop passed pawns. A passed pawn has no opposing pawn in its own file or in
either adjacent file. Therefore, a passed pawn is a relatively valuable piece because
its path to promotion is somewhat open. 

• Pawns Weakness sets how hard the personality avoids positions where a pawn is
unprotected, is rendered immobile, or otherwise weakens the overall pawn struc-
ture. The higher the setting, the more the personality protects its pawns.



Minutes Per Game lets you specify the number of minutes each player has to complete
the game. If you specify under 10 minutes per game, you are playing “blitz chess,”
which is one of the most popular forms of chess. Anything between 10 and 30 min-
utes per game is known as “rapid chess.” More and more tournaments are being
played at these time controls, including the Professional Chess Player Association’s
Grand Prix circuit. If you select this time control, type the number of minutes in the
Minutes edit box.

Fischer Style lets you assign each player a specified number of minutes to complete a
game, with a certain number of bonus seconds added to the game each time a player
makes a move. If you select this time control, type the minutes and bonus seconds in
the respective edit boxes. 

Hourglass lets you assign each player a specified number of seconds per move at the
start of the game. As one player loses their time, the other player gains the same
amount of time (like an hourglass). By moving quickly, you can force your opponent
to do the same. If you select this time control, type the seconds in the Seconds Per
Move edit box.

Infinite Time doesn’t set any time limitations on your game. Players can take as long as
they want, and the game lasts indefinitely. If you’re playing against a CHESSMASTER per-
sonality, and the game leaves the opening book, it might take a long time to move. In
this case, choose Force Move from the Actions menu. Remember, the longer you let
the personality think, the better it plays!

Equal Time forces the computer personality to match the time you take to make a
move, based on the average time per move. For example, if you complete five moves
in 50 seconds, the computer personality will take approximately 10 seconds to make
its next move. In short, if you move slowly, the computer personality moves slowly;
if you move quickly, so does the computer personality. This time control doesn’t apply
to human players.

Choosing Your Color and Switching Sides

CHESSMASTER automatically assigns you as the Bottom player with white chess pieces.
You can change side on which you play, as well as the color of your pieces. 

To change your side and piece color

1. From the Game menu, choose Set Up Game. The Setup Game Details dialog appears.

2. Make sure the Colors tab is displayed.

3. Clear the [Your Name] Plays From Bottom box, and then click the Rotate Board
button twice. You are now the Top player with the black chess pieces.

You can also use the Colors tab on the Setup Game Details dialog to switch sides 
with your opponent in the middle of game, so that each of you can continue the game
from the other’s perspective. In other words, the white player takes the black pieces
and the black player takes the white pieces. You can switch sides at anytime during
an unrated game.
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Because not all of us always have time to play international chess, CHESSMASTER 7000
offers a virtually infinite variation of time controls. Players can choose from eight dif-
ferent time controls for an unrated game. 

To select a time control

1. From the Game menu, choose Set Up Game. The Set up Game Details dialog appears.

2. Click the Time Controls tab.

3. Click either Same Time Controls or
Separate Time Controls to specify 
whether you want to give both players 
the sae or different amounts of time 
respectively. If you click Separate Time 
Controls, two sets of time boxes 
appear; one for each player. This is 
useful if you want more time than 
your opponent, or if you want to com
pare different CHESSMASTER personali-
ties. These options don’t affect Infinite 
Time or Equal Time, which are 
described below. 

4. From the drop-down list, select one of the following time controls: 

Moves/Minutes lets you specify the number of moves each player needs to make in the
number of minutes (which you also specify). This is standard for serious chess. Most
international tournaments are played at this rate. If you don’t make the required num-
ber of moves in this time, you lose. If you select this time control, type the number of
moves and minutes in the respective edit boxes. Choose Moves/Minutes (up) if you
want the time to elapse from 0 minutes up, and choose Moves/Minutes (dn) if you
want the time to elapse from the maximum time you specify down.

Seconds Per Move lets you specify the number of seconds each player has to make a
move. This time control instructs the players to spend a certain number of seconds
on average thinking about each move. If you select this time control, type the num-
ber of seconds in the Seconds Per Move edit box. Choose Seconds Per Move (up) if
you want the time to elapse from 0 seconds up, and choose Seconds Per Move (dn) if
you want the time to elapse from the maximum time you specify down.



To move a piece with your mouse

1. Place the pointer over the chessboard. The pointer changes to a hand.

2. Click the piece you want to move and drag it to its destination square. The hand
grabs the piece as you drag it. If you make an illegal move (inconsistent with the
laws of chess), CHESSMASTER 7000 returns the piece to its original square, and if
Illegal Move Commentary is on in the Sounds dialog, CHESSMASTER tells you why
the move is illegal. 

3. If you make a mistake, choose Takeback Move from the Actions menu.

Note: If you’re having difficulty grabbing a chess piece, make sure the dot on the index fin-
ger of the hand is inside the square of the piece you want to move.

Two options on the Board Settings dialog — Quick Entry and Sliding Pieces — let you
determine how you and your opponent move pieces on the board. For more infor-
mation, see “Using the Board Settings Dialog” on page 13 in chapter 2, “Defining Your
Room Environment.”

You can also use the Rules tab in the Setup Game Details dialog to turn Touching on.
Touching lets you grab a piece and start moving it, and then change your mind and
move another piece. This is legal as long as you place the first piece back in its 
original square before you release it. If Touching is off, you must move the first legal
piece you touch. 

Moving Pieces with the Keyboard

You can use the keyboard to move pieces by typing the moves in the current notation.
For example, if the current notation is Algebraic, and you want to move a pawn from
d2 to d4, you simply type d4.

To move a piece with the keyboard

1. Move the pointer over the square of the piece you want to move. 

2. Type the destination square using the current notation and press Enter. 

Note: For more information on chess notation, see “Specifying Chess Notation” on page 15
in chapter 2, “Defining Your Room Environment.”

Using the Move List

CHESSMASTER records each move you and your opponent make during a game. It
records the moves in the Move List, using the current chess notation. The Move List
(which is stored with its corresponding game) is displayed in the Game Status win-
dow, which you can access from the Windows menu.
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Switching sides interrupts the computer’s thinking. This means that if you’re playing
a computer personality, it won’t make its next move until you wake it up. To resume
the computer’s thinking so that it can make its next move, choose Wake Up! from the
Actions menu.

Note: If you’re playing black, and you want to flip the board so that white is on top, choose
Flip Board from the Preference menu or the right-click menu.

Touching Pieces and Playing Blind

When you play an unrated game, you can specify whether touching is allowed and
whether one or both players play blindfolded. 

If Touching is on, and you grab a piece and start moving it, you can change your 
mind and move another piece. However, you must place the first piece back in 
its original square before you release it. If Touching is off, you must move the first
legal piece you touch.

If Blindfold Play is on for both players, they can’t see their opponent’s pieces on the
board. This option lets you experience the most difficult form of chess in which you
must remember moves without seeing them on screen. Even advanced players have a
difficult time playing chess blindfolded, so don’t get discouraged if you try it!

Touching and Blindfold Play are considered rules of your game. You can set the rules
of your game using the Setup Game Details dialog.

To turn Touching and Blindfold Play on and off

1. From the Game menu, choose Set Up Game. The Setup Game Details dialog appears.

2. Click the Rules tab, and then check or clear the appropriate options.

Moving Pieces
After you specify the details of your unrated game (see “Playing an Unrated Game” on
page 17), you are ready to play. A game begins as soon as you or your opponent
makes the first move. If you are White, you need to make the first move. If your oppo-
nent is White, you must wait until your opponent moves.

You can move pieces using the mouse by clicking and dragging, or using your key-
board by typing each move in the specified notation. When you play an unrated game
in the Game Room, you can also take back moves, replay a move, and force your com-
puter opponent to move.

Moving Pieces with the Mouse

Using the mouse is the easiest and most common way to move your pieces.



3. From the File of Type drop-down list, choose Text File (*.TXT). 

4. Select the Move List you want to open, and then click Load. CHESSMASTER opens the
Move List in the specified tab on the Annotation Window.

5. If the Annotation Window isn’t open, choose Annotation from the Windows Menu,
and then click the tab to which the Move List was opened.

Printing the Move List and Board Position

When you’re in the Game Room (as well as in other rooms), you can print the Move
List and the current Board Position at any time.

To print the Move List

1. From the File menu, choose Print > Move List. The Annotation Type dialog appears.

2. Specify which annotation you want to include (if the current Move List has 
annotations):

• None prints the Move List without annotations.

• Player prints the Move List with the annotations you entered in the Player tab
on the Annotation window.

• Analysis prints the Move List with Chessmaster’s annotations about the tactical
and strategic points of each move.

• Auto-Annotation prints the Move List with CHESSMASTER’S annotations, which
evaluate piece positions and possible variations of these positions.

3. Click OK. CHESSMASTER prints the Move List with the annotations you selected. The
name of each player appears at the top of the list, followed by all moves in the cur-
rent notation.

To print the current board position

• From the File menu, choose Print > Board Position. CHESSMASTER prints the image
of the current chessboard.

IBM Graphics, HP Laser, or compatible printers print a graphical representation of the
board. Other printers print text characters.

Note: To perform standard Windows® Print operations, such as selecting a printer, specify-
ing a page range, and specifying the number of copies, choose Print > Printer Setup from the
File menu. This opens the standard Windows Printer Setup dialog.
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You can copy the current Move List to the Windows“ clip-
board, and then paste it into any Windows text editor or
to any one of the tabs in the Annotation window. You can
also save it to an ASCII text (.txt) file that you can open
later in any Windows application.

To open and close the Move List

• From the Windows menu, choose Game Status. The
Game Status window appears displaying the Move List.
The chess piece symbol next to the menu option indi-
cates that it’s open.

To copy the Move List to the Windows“ clipboard

1. From the Edit menu, choose Copy > Move List. The
Annotation Type dialog appears.

2. Select the Annotation tab to which you want to copy the Move List, or choose None
if you don’t want to paste the Move List into the Annotation window, and then click
OK. CHESSMASTER copies the Move List to the Windows“ clipboard as ASCII text.

To paste the Move List to the Annotation window

• From the Edit Menu, choose Paste Moves. CHESSMASTER copies the Move List from
the Windows“ clipboard into the specified tab on the Annotation Window.

To save the Move List

1. From the File menu, choose Save. The File Save dialog appears.

2. From the Save In drop-down list, specify the folder where you want to save the
Move List.

3. From the Save As drop-down list, choose Move List. This indicates that you want
to save the Move List to a text (.txt) file and displays the other .txt files in the spec-
ified folder.

4. In the File Name box, type a name for the Move List you’re saving, and then click
Save. The Annotation Type dialog appears.

5. Select the Annotation tab to which you want to copy the Move List, or choose None
if you don’t want to paste the Move List into the Annotation window, and then click
OK. CHESSMASTER saves the Move List as an ASCII text file to the folder you specified.

To open a Move List

1. From the File menu, choose Load. The File Open dialog appears.

2. From the Look In drop-down list, specify the folder that contains the Move List you
want to open.



To force your computer opponent to move

• From the Actions menu, choose Force Move.

Force Move makes your computer opponent move immediately, choosing the best
move it has considered thus far. Although this is a useful feature, avoid overusing it.
CHESSMASTER often makes totally unexpected moves, and part of the process of getting
better is the ability to respond properly to surprise moves.

Waking Up Your Opponent

If you’re playing a computer personality, it’s important to know that two actions can
interrupt the computer’s thinking — taking back a move and switching sides. (See page
29 and page 24 respectively.) In either case, CHESSMASTER lets you wake up your oppo-
nent, so that it can start thinking about its next move and resume the game.

To wake up your opponent

• From the Actions menu, choose Wake Up!.

Pausing a Game

Given the depth of strategy, the required thinking, and the intense concentration — all
of which play a role in the game of chess — it is not uncommon for a chess game to last
an extended period of time. Given this, CHESSMASTER lets you pause a game at any time.

To pause a game

1. From the Actions menu, choose Pause.

2. Click OK to resume the game.

Adjourning a Game

CHESSMASTER lets you suspend, or adjourn, a game so that you can continue it at a later
time. When you adjourn a game, CHESSMASTER retains the position of both black and
white pieces, as well as the elapsed game time. You can only adjourn a game when it
is your turn to move.

To adjourn a game

1. From the Actions menu (or right-click menu), choose Adjourn. 

2. Specify the folder, file type, and file name to which you want to save the game. You
should always save adjourned games as CHESSMASTER Game (.cmg) files.

3. Click Save. CHESSMASTER saves the adjourned game to the specified location and 
file name.
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Taking Action
The Game Room provides several features that give you more control over your game.
These features are located in the Actions menu, and they allow you to do things like:

• Take back a move when you make a mistake or change your mind, and then replay
that move immediately after.

• Force your computer opponent to move when it’s taking too long, or wake up your
computer opponent when certain actions confuse it or interrupt its thinking.

• Pause a game for a quick break or adjourn a game so you can continue it later.

• Offer a draw when it seems unlikely that you or your opponent can win, or resign
from a game when it seems unlikely that you yourself will win.

Taking Back Moves

When you’re playing an unrated game in the Game Room, you can take back your
last move. Taking back your last move is useful if you make a mistake.

To take back your last move

• From the Actions menu, choose Takeback Move.

Note: If you take back a move, and you’re playing a computer personality, the computer gets
interrupted. In this case, choose Wake Up! from the Actions menu to tell your opponent to
make its next move.

If you want to take back all your moves to the beginning of the game, choose New Game
from the Game menu. For more information, see “Starting a New Game” on page 44. 

Replaying Moves

CHESSMASTER lets you replay a move that you just took back (using Takeback Move on
the Actions menu).

To replay the move you just took back

• From the Actions menu, choose Replay Move.

Note: To replay all moves in a game, Open the Game Status window from the Windows
menu, and click the left-most VCR button.

Forcing Your Opponent to Move

If you’re playing a computer personality who’s taking too long to move, CHESSMASTER

lets you force your opponent to make that move. This feature is useful for speeding
up the game when the move your opponent should make is obvious, or if you’re play-
ing under the Infinite Time control.



Getting Advice
Advanced chess players understand the consequences of a move before they make it.
Once you’re good at noticing board space, isolated pawns, pinned and skewered
pieces, and strong pawns, you’re ready to use the CHESSMASTER features that can help
you develop and speed your tactical skills.

When you’re playing an unrated game in the Game Room, you can get tactical advice
on your next move, using one of the three following features that CHESSMASTER pro-
vides in the Mentor menu:

• Quick Hints, which gives you suggestions when you’re having a difficult time 
making the next move.

• Move Advice, which uses voice and sound to give advice on the next move to make,
to explain the effect of the move, and to provide a replay of the game plan in easy-
to-understand terms.

• Coach, which displays a summary of all possible moves and their variation name or
significance.

Using Quick Hints

If you’re at a complete loss about the next move to make, you can ask Quick Hints to
give you a suggestion.

To use Quick Hints

1. From the Mentor menu, choose Quick Hints. The Quick Hints dialog appears with
a suggestion for the next move to make.

2. Click Move to make the suggested move, or click Cancel if you don’t want to make
the suggested move. 

Note: The Quick Hints feature uses the current chess notation to suggest a move. Until you
become familiar with chess notation, perhaps you should click Move so that Chessmaster can
make the move for you. For more information on chess notation, see “Specifying Chess
Notation” on page 15 in chapter 2, “Defining Your Room Environment.”

Using Move Advice

Move Advice on the Mentor menu analyzes your current board position, and then
uses Illustrated Voice Analysis (IVA) to suggest the best possible move, communicate
the effect of the move, and then replay an overall plan in easy-to-understand terms.
In short, Move Advice helps you see how each move in a sequence accomplishes a
specific tactical end.

When you use Move Advice, you specify how long you want CHESSMASTER to analyze
your position. The more time you specify, the more moves it finds, and the better the
moves are strategically. Move Advice then suggests the best move from the moves that
CHESSMASTER finds.
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You can resume an adjourned game by opening the corresponding CHESSMASTER Game
(.cmg) file. When you open the game, CHESSMASTER reveals your sealed move to your
opponent, and your game begins from where you left off.

To resume an adjourned game

1. From the File menu, choose Load. The File Open dialog appears.

2. From the Look In drop-down list, select the folder that contains the adjourned game.

3. From the File of Type drop-down list, select Chessmaster Games (.CMG). All the
Chessmaster Game (.cmg) files appear.

4. Select the game, and then click Load. CHESSMASTER opens the game and it resumes
by making your sealed move.

Offering a Draw

If it seems unlikely that you or your opponent can win the game, CHESSMASTER lets
you offer a draw. CHESSMASTER won’t agree to a draw if it believes it has even the slight-
est advantage — even if the position is objectively drawn. Also, CHESSMASTER won’t
agree to a draw early in the game, even if it has a technical disadvantage. In short, you
should only offer a draw if you’re convinced that you have an advantage, or that the
current position has no play at all.

To offer a draw

1. From the Actions menu (or right-click menu), choose Offer Draw. If CHESSMASTER

accepts the draw, a message appears indicating its acceptance. If CHESSMASTER

declines the draw, a message appears telling you to play on.

2. Click OK to end the game or continue the game respectively. 

If CHESSMASTER declines the draw, and you still want to end the game, you can resign
from the game by choosing Resign from the Actions menu or right-click menu.

Resigning from a Game

If you’re getting frustrated and it seems unlikely that you can win, CHESSMASTEr lets
you resign from the game at any time. 

To resign from a game

1. From the Actions menu (or right-click menu), choose Resign. A message appears
asking if you want to resign.

2. Click Yes.



To use the chess coach

1. From the Mentor menu, choose Chess Coach. The Chess Coach window appears.
A chess piece next to the option in the Mentor menu indicates the Chess Coach
window is open.

2. Click the tab you want to use — Advice, Database Findings, or Teaching Modes.
The Teaching Modes tab is described in the next section.

3. To close the Chess Coach window, select it again from the Mentor menu or click
the Close icon (X) on the upper-right corner of the window.

If you open the Chess Coach window during a game, CHESSMASTER provides a running
commentary on the tactical features of a position. If you’re not sure why a move does
what the Chess Coach says, make the move on the board, examine the position care-
fully, and then try to determine what the Chess Coach means. 

Note: If you use one of the moves that the Chess Coach suggests, remember that you aren’t
stuck with the move you just made. You can take back a move at any time by choosing
Takeback Move from the Actions menu.

Using the Teaching Modes

The Teaching Modes tab in the Chess Coach window (described above) lets you take
advantage of the audio and visual tips that CHESSMASTER provides. These teaching
modes can help develop and improve your strategic and tactical playing skills and
enhance your awareness of the different board positions during game play.

If you’re new to chess or just want to improve your skills, you can use the teaching
modes to inform you of minor tactics, threatened pieces, and board coverage by high-
lighting and ghosting the appropriate pieces on the chessboard.

The CHESSMASTER teaching modes are described below:

• Teaching Off turns the currently selected teaching mode off.

• Legal Moves for Selected Piece shows you all the possible moves a selected piece can
make. If you’re new to chess, this teaching mode can aid your game. You simply
click the piece you want to move, and ghost pieces immediately appear in all the
squares to which the piece can move. You can then drag your piece to make (what
you think is) the best move. If a destination square is occupied by an opponent’s
piece, that piece is ghosted or opaque, indicating you can capture it.

• Pieces That Can Be Captured shows all pieces (yours and your opponent’s) that can be
captured based on the current board position. This is a basic teaching mode that you
can use when you’re confident that you understand the basic moves of each piece
(from using “Legal Moves for Selected Pieces” described above.) This teaching mode
is helpful to beginning players because it gives you a sense of the moves you should
be thinking about.
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To use Move Advice

1. From the Mentor menu, click Move Advice. The Move Advice dialog appears.

2. Take the advice or click Advice, type the number of seconds you want CHESSMASTER

to use to analyze your position and determine the best move, and then click OK.
CHESSMASTER uses the specified amount of time to think, and then suggests a move.

3. Do one of the following: a) scroll through the text to read about the suggested
move, and then make the move; b) click Print to print a hard copy of the sugges-
tion; c) click Play to hear IVA explain the suggested move. To stop the IVA, click
Stop to stop and rewind it to the beginning.

4. Click the Close icon (X) at the upper-right corner of the dialog to close it.

Getting Coached

The CHESSMASTER Game Room comes with a chess coach that you can access from the
Mentor menu. The chess coach appears as a window with four tabs:

• Advice, which provides a summary of all possible moves and their variation name or
significance. This gives you a great way to learn how the opening variations are relat-
ed to each other. When the game is out of the opening book, a short description of
each move’s impact on the game appears. This might be “Pins knight,” “Threatens
mate,” or “Hangs queen.” The Advice tab also explains the tactical motives the
moves involve. For example, it explains when a move pins another piece or relieves
a pin; and when a move forks pieces, checks the opponent’s King, gets out of check,
or skewers two pieces at once. When this tab is displayed, you can double-click any
move to make that move.

• Database Findings, which lists all the games in the database that have the current
position, and for those games, it shows the number of wins, draws, and losses. It
also shows the percentage of winning games.

• Teaching Modes, which lists a number of audio and visual tips that you can turn on
and off during a game. Given the extent of the teaching modes and the benefit they
provide, this tab is described in a section of its own. See “Using the Teaching Modes”
on page 34.

Like any good coach, the Coach window provides you with a variety of options, and
lets you decide which of those options to use.



To use the teaching modes

1. From the Mentor menu, choose Chess Coach. The Chess Coach window appears.
A chess piece next to the option in the Mentor menu indicates the Chess Coach
window is open.

2. Click the Teaching Modes tab.

3. Click the teaching mode you want to use.

4. To close the Chess Coach window, select it again from the Mentor menu or click
the Close icon (X) on the upper-right corner of the window. CHESSMASTER uses the
teaching mode you selected during all subsequent games, until you turn Teaching
Mode off, or select another teaching mode.

Note: You can only turn on one teaching mode at a time. Also, some chess sets and board col-
ors don’t display teaching mode at its best. If you don’t like how teaching mode displays,
experiment with different chess sets.

Analyzing Your Game
Analyzing your game involves examining your personal strengths and weaknesses and
developing a plan with special exercises that emphasize your strengths and eliminate
(or at least limit) your weaknesses.

CHESSMASTER provides several features that you can use to analyze and practice all
aspects of your game, including each individual move in your game, specific chal-
lenging board positions, and your endgame.

With Chessmaster’s analyzing features, you can:

• Save and load a game, so you can examine it move by move.

• Study a game by listening to and reviewing CHESSMASTER’S analysis of your game.

• Set up a specific position on the chessboard, and then either have CHESSMASTER ana-
lyze it for you or play it out yourself.

• Find a mating line for the current board position and solving for mate.

Saving and Opening Games

The first step to effective game study is saving as many of your games against as many
different opponents as possible. After you save a game, you can open it at any time
and examine it move by move. This is essential in gaining an understanding of your
personal strengths and weaknesses as a chess player. 
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• Threatened Pieces shows all the pieces that can be captured by you and your oppo-
nent in the next move. In other words, it ghosts all the pieces that are under attack
for the player who is about to move. Like “Pieces That Can Be Captured” described
above, this is a basic teaching mode that you can use when you’re confident that you
understand the basic moves of each piece. It’s helpful to beginning players because
it gives you a sense of the moves you should be thinking about.

• Pinned Pieces shows the pieces that cannot or should not move because they’re pro-
tecting a more valuable piece. When a piece is pinned against the King, it can’t legal-
ly move. When a pinned piece has legal moves that don’t expose the other piece to
attack, it’s partially pinned. The ability to identify pinned pieces is a middlegame
tactic essential to the repertoire of any good chess player.

• Skewered Pieces exposes pieces that are protecting pieces of lesser attack value on the
same rank, file, or diagonal. The most commonly skewered piece is the King (often
against the Queen). The ability to identify skewered pieces is a middlegame tactic
essential to the repertoire of any good chess player.

• Isolated Pawns, a concept introduced by Yasser Seirawan, shows pawns that are not
directly supported by another pawn of the same color and, therefore, are potential-
ly weak. Use this teaching mode to instantly see your isolated pawns, as well as your
opponent’s. CHESSMASTER highlights the isolated pawns, so you quickly see what
your weaknesses are.

• Passed Pawns shows pawns with no enemy pawns in front or adjacent to the same
file. Passed pawns are considered strong. The ability to identify passed pawns is an
endgame tactic essential to the repertoire of any good chess player.

• Promote Threats shows pawns that are threatening to become another piece by moving
to the opposite side of the board on its next move. The ability to identify threatening
pawns is an endgame tactic essential to the repertoire of any good chess player.

One the major chess themes that former American Champion Yasser Seirawan uses in
his tutorial modules is the concept of gaining space. The player that controls greater
board space generally has the advantage in a chess game. In the abstract it may seem
like a difficult concept, but CHESSMASTER provides two teaching modes to help you
quickly grasp how much space you and your opponent control — “White’s Coverage
of the Board” and “Black’s Coverage of the Board.” If either of these teaching modes is
on while you’re playing a game, CHESSMASTER highlights the portion of the board con-
trolled by either White or Black so you can instantly see who controls more space.
These teaching modes can be useful to see how your moves (and those of your oppo-
nent) are altering the balance of space during the game.

Note: Because these modes obscure the board squares, you should not leave them on for
extended periods.

• White’s Coverage of the Board shows the squares to which the black King cannot
move. This teaching mode is particularly useful during an endgame.

• Black’s Coverage of the Board shows the squares to which the white King cannot move.
This teaching mode is particularly useful during an endgame.



5. If the Move List isn’t open, choose Game Status from the Windows menu, and then
use the VCR buttons to scroll through each move of the game.

Note: Chessmaster also provides a library of classic games annotated by grandmasters
including GM Larry Evans and GM Yasser Seirawan. For more information on studying and
analyzing the classic games, see chapter 6, “The Library.”

Annotating Your Games

You can use Game Analysis on the Mentor menu to study a game. Game Analysis
plays through the game and provides commentary in the Auto-Annotation tab of the
Annotation window, focusing on the tactical and strategic points of individual moves.
It is primarily intended for beginning and intermediate players.

Game Analysis also lets you play through the commentary, using the VCR buttons and
the Move List in the Game Status window. It focuses on possible variations and eval-
uates positions using Chessmaster’s decimal point system. In that system, a one-point
(1.0) advantage is equivalent to possessing an extra pawn; a three-point (3.0) advan-
tage to possessing an extra minor piece, a five-point advantage (5.0) to possessing an
extra rook, and a nine-point advantage (9.0) to having an extra queen. CHESSMASTER

expresses advantages less than a pawn in fractions of a point. For example, a .50-point
advantage is equivalent to half a pawn advantage.

You can annotate and analyze Move Lists of any game (completed or not) on the
chessboard. This includes games you have loaded from a file or games that you are
currently playing. 

To annotate a game

1. From the Windows menu, choose Game Status to display the Move List.

2. Make sure the current game is at the beginning of the Move List using the VCR but-
tons at the top of the Move List.

3. From the Mentor menu, choose Game Analysis. The Analysis Time dialog appears.

4. Specify the number of seconds you want CHESSMASTER to spend analyzing each
move, and then click OK. CHESSMASTER takes the specified amount of time to ana-
lyze the Game, and then displays a message indicating it’s finished.

5. Click OK, and then choose Annotation from the Windows menu to open the
Annotation window.

6. To view the Annotation, click the Auto-Annotation tab, and click Play, or use the
Play VCR button in the Game Status window. CHESSMASTER scrolls through the
Move List providing commentary, text, and visual cues focusing on the tactical and
strategic points of each move. You can click Pause to stop the Auto-Annotation, or
you can use the VCR buttons in the Game Status window to scroll through the
moves one at a time.
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CHESSMASTER lets you save the current game (completed or not) to a Chessmaster
Game (.cmg) file or to a Portable Game Notation (.pgn) file. Use Chessmaster Game
(.cmg) if you want to save all annotations, including the opponents, analysis, auto-
annotation, and illustrated voice analysis information. Use Portable Game Notation
(.pgn) if you want to open the game in a text application.

Note: Before you save a game, we recommend you create a My Games folder (under the
Chessmaster 7000 folder) for the games you want to save.

To save a game

1. From the File menu, choose Save. The File Save dialog appears.

2. From the Save In drop-down list, 
specify the folder where you want
to save your game.

3. From the Save As drop-down list, 
choose a file type for your game. 
Select Chessmaster Game (.cmg) if 
you want to open the game later in 
CHESSMASTER. Select Portable Game 
Notation (.pgn) if you want to 
export the game to another 
chess application.

4. In the File Name box, type a name for the game you’re saving. You can use the
default (based on the players and the date) or type your own.

5. Click Save. CHESSMASTER saves the game to the specified folder, file type, and name.

CHESSMASTER lets you open saved games that you can study and analyze. You can open
Chessmaster Game (.cmg) files from earlier versions of CHESSMASTER , as well as
Portable Game Notation (.pgn) files.

To open an existing game

1. From the File menu, choose Load. The File Open dialog appears.

2. From the Look In drop-down list, specify the folder that contains the game you
want to open. If you used our recommendation and saved your games to a My
Games folder under the Chessmaster 7000 folder, go to C:\Program
Files\Chessmaster 7000\My Games.

3. From the File of Type drop-down list, specify the type of game you want to open.
Select Chessmaster Game (.cmg) to open a game from an earlier version of
CHESSMASTER (2000 and later), or select Portable Game Notation (.pgn) to open a
game from another chess program. 

4. In the Open As edit box, make sure Auto is selected, and then click Load.
CHESSMASTER opens the selected game on the chessboard.



3. Use the piece, hand, and X buttons as necessary to set up the board position you
want. Click any piece button, and then click the location on the chessboard where
you want that piece to appear; click the Hand button to move an existing piece to
a new location; and click the X button to remove a piece from the chessboard.

4. Click Finish. If there are no illegal positions (for example, both Kings in check), the
Complete Board Setup dialog appears.

5. Use the Side to Move options to specify whose turn it is. Click White if you want
the white pieces to move first; click Black if you want the black pieces to move first.

6. Use the Castle Status options to specify whether or not castling is legal for the board
position. These options are only available if the Kings and either of their Rooks are
on their original squares. If neither the King nor the Rooks have moved in the
board position, castling is legal, and you can check the appropriate Castling option.
If either the King or its Rooks have moved since their original positions, castling is
illegal, and you should clear the appropriate Castling option.

7. Choose OK. CHESSMASTER displays the board position you set up.

Note: You can cancel the Setup Board Position operation at any time and return to the game
in progress. Simply click the Abandon button.

Solving for Mate

CHESSMASTER provides a Solve for Mate feature that teaches you how to recognize
potential checkmates well in advance. When you use this feature, CHESSMASTER finds
a mating line for the current board position. If you’re playing a friend or a personali-
ty, and you think you can capture their King, Solve for Mate can verify your strategy.

You can also use Solve for Mate to compare the moves you made to checkmate an
opponent with those that CHESSMASTER would make. After you checkmate your oppo-
nent, back up a few moves, and then use Solve for Mate to see what CHESSMASTER

would have done.

To find a checkmate

1. From the Mentor menu, choose Solve for Mate. The Solve for Mate dialog appears.

2. Type the number of moves you want CHESSMASTER to look ahead to solve for check-
mate. The default is 4, and you can specify up to 30. If you enter more than 5 —
you shouldn’t need more than this — the search can take a while.

3. Click OK. CHESSMASTER searches all possible positions looking for checkmate and
displays the number of the positions as it analyzes the game. When CHESSMASTER

finishes its search, and it finds the checkmate in the number of specified moves, it
asks if you want to see the moves. 

4. Click Move to see the moves, and then click OK to reset the board to its 
original position.
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7. To view the results of the Game Analysis, click Analysis in the Annotation window,
and click Play. CHESSMASTER scrolls through the Move List providing commentary
focusing on possible move variations and evaluates positions using Chessmaster’s
decimal point system.

8. Click Pause to stop the analysis, or use the VCR buttons in the Game Status win-
dow to scroll through the moves one at a time.

9. To add your own annotations to a Move List, click Player in the Annotation win-
dow, select the move you want to annotate in the Move list, click Edit, and then
type your comments.

10. Click OK to end your annotation or use the VCR buttons in the Game Status win-
dow to scroll through the moves. (Illustrated Voice Analysis is not available for
player annotations.)

To save the game with annotations and analysis, choose Save from the File menu,
select Chessmaster Games (.CMG) as the file type, specify a name and location for 
the game, and click Save. CHESSMASTER game (.cmg) files save all annotations and
analysis with a game.

Note: To turn sound on and off for Game Analysis, choose Sound from the Preferences 
menu, click the Voice tab, and then check or clear Auto-Annotation. For more information, 
see “Setting Up Sounds, Voice, and Effects” on page 11 in chapter 2, “Defining Your 
Room Environment.”

Setting Up a Position

CHESSMASTER provides a Board Position feature that lets you set up a specific position
on the chessboard, and then either have CHESSMASTER analyze it for you, or you can
play it out yourself.

Note: You cannot use this feature to set up an illegal position.

To set up a position

1. From the Game menu, choose 
Set Up Position. The Setup 
Board Position dialog appears.

2. Click Clear Board to clear the 
board of all the pieces except 
the two Kings, or click 
Starting Position to set the 
board to its starting position. 
Clear Board is helpful if you

want to set up a position that requires few pieces, and Starting Position is helpful
if you want to set up a position that requires several pieces. 



To use Thinking Lines

1. From the Windows menu, choose Thinking Lines. The Thinking Lines window
opens. A chess piece next to the Thinking Lines option indicates that it’s open.

2. Watch the window dynamically update as CHESSMASTER considers its best line. 

3. To close the Thinking Lines window, select it again from the Windows menu or
click the Close icon (X) on the upper-right corner of the window.

Copying Games from Other Rooms
CHESSMASTER 7000 introduces a new feature that lets you copy a game from any other
room into the Game Room.

To copy a game from another room

1. From the Edit menu, choose Copy Game From, and then from the cascading menu,
choose the room from which you want to copy a game. CHESSMASTER asks you if
you want to save the current game.

2. Click Yes to save the current game, or click No to copy the game from the 
specified room on to the current chessboard. If you click Yes, the File Save 
dialog appears.

3. From the Save In drop-down list, specify the folder where you want to save your game.

4. From the Save As drop-down list, choose a file type for your game. Select
Chessmaster Game (.cmg) if you want to open the game later in CHESSMASTER.
Select Portable Game Notation (.pgn) if you want to export the game to another
chess application.

5. In the File Name box, type a name for the game you’re saving. You can use the
default (based on the players and the date) or type your own.

6. Click Save. CHESSMASTER saves the current game to the specified folder, file 
type, and name, and then copies the game from the specified room onto the 
current chessboard.

Copying the Move List and Chessboard
The Copy option on the Edit menu uses a cascading menu of additional options that
let you copy the following information to the Windows® clipboard. After you copy
information to the Windows® clipboard, you can insert it into another application
(such as Microsoft® Word) using the application’s Paste command.

• Moves List copies the Move List to the Windows® clipboard using the current nota-
tion. You must make at least one move before you can copy the Move List.

Note: For more information on chess notation, see “Specifying Chess Notation” on page 15
in chapter 2, “Defining Your Room Environment.” Also, before you paste a copied Move List
into a word processing application, use the application’s Font command to select the
Chessmaster TrueType font.

4241

Watching How CHESSMASTER Thinks
While you’re playing an unrated game in the Game Room, CHESSMASTER provides two
ways for you to look into its mind and see how it thinks. You can use one or both of
the following options from the Windows menu:

• Visual Thinking, which displays a pictorial representation of a mini chessboard that
automatically updates as CHESSMASTER considers its best line.

• Thinking Lines, which shows the research process that CHESSMASTER makes to predict
the next 20 best moves. It displays the best moves in plies, a string of individual
moves made by the Black and White pieces.

Important: Visual Thinking and Thinking Lines are available only in the Game Room. For
detailed information on the other options in the Windows menu (which are common to more
than one room), see chapter 2, “Defining Your Room Environment.”

Using Visual Thinking

The Visual Thinking window displays a pictorial representation of a chessboard to
depict Chessmaster’s thinking as it considers its best line. The pieces on the chess-
board move dynamically to reflect Chessmaster’s current thinking. The pictorial rep-
resentation uses Figurine Algebraic notation.

To use Visual Thinking

1. From the Windows menu, choose Visual Thinking. The Visual Thinking window
opens. A chess piece next to the Visual Thinking option indicates that it’s open.

2. Watch the chessboard dynamically update as CHESSMASTER considers its best line. 

3. Use the VCR controls to move back and forth in the display. Fast Rewind goes to the
beginning of the thought process; Back rewinds one move back; Forward moves one
move forward; and Fast Forward moves to the end of the thought process.

4. Use the Pause and Resume buttons to pause and resume the thinking respectively.

5. To close the Visual Thinking window, select it again from the Windows menu or
click the Close icon (X) on the upper-right corner of the window.

Using Thinking Lines

The Thinking Lines window provides information on the research process that
CHESSMASTER makes to predict the next 20 best moves. It displays the moves (using
coordinate notation) in plies, which are a series of Black and White turns. It also dis-
plays the time it takes to predict the moves, the number of moves (Depth) that
CHESSMASTER is thinking about, and the material and positional advantage (Score) that
would result if all the moves are played out to the end of the line.

If the Score is a positive number, White is winning by the specified number of pawns.
If the Score is a negative number, Black is winning by the specified number of pawns.
The Score considers the changes in material points (the chess pieces), the position
(the overall quality of each player’s position on the board), and items relating to chess
knowledge. A pawn is worth 1.0 point, and a queen is worth 9.0 points.



Entering Game Information
CHESSMASTER provides a Game Information dialog that lets you enter, store, and dis-
play pertinent information about the current game.

To use the Game Information dialog

1. From the Game menu, choose Game Information. The Game Information dialog
appears.

2. In the Title box, keep the default title, or type a new title of your choice, such as
“My Game with Chessmaster.” 

The White and Black boxes display information from the Game Status window —
player name, rating, elapsed time, and the type of time control being used.

3. In the Event box, type the event at which you are playing (if any).

4. In the Site box, type the location of the game, such as Novato, California.

5. In the Annotator box, enter the name of the annotator.

The Round box displays the round number in which the game was completed, the
Date box displays the date the game was played, and the ECO box displays the open-
ing code in the current chess notation.

6. In the Remarks box, enter any comments you have regarding the game.

7. In the Game Results portion of the dialog, specify the status or the result of the
game. Click either Game Not Over, White Won, Black Won, or Draw. You can
change this when the game ends.

8. Click OK. CHESSMASTER stores the information you entered with the corres-
ponding game.

Starting a New Game
When you’re in the Game Room, you can start a new game at any time, even if you’re
in the middle of an existing game.

To start a new game

1. From the Game menu, choose New Game. The New Game dialog appears asking
you if you want to restart the same game or choose a different opponent and set up
a new game.

2. Click OK to re-start the same game, or click Player to choose a new opponent
and/or set up a new game. If you click Player, the Set up Game Details dialog
appears with the settings of the last game.

3. Set up the new game using the tabs and options in the Set up Game Details dialog.
For information on specifying the details of an unrated game, see “Playing an
Unrated Game” on page 17.
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• ASCII Board copies the current board position in ASCII text format to the Windows“
clipboard. An ASCII board consists of characters and dashes. The dashes represent
empty squares, and the characters represent the chess pieces. For example, BR rep-
resents the Black Rook, WR represents the White Rook, BN represents the Black
Knight, WN represents the White Knight, and so on. The following illustrates an
example of an ASCII chessboard:

BR BN BB BQ BK BB — BR

BP BP BP BP BP BP BP BP

— — — — BN — — —

— — — — — — — —

— — WP — — — — —

— — — — — — — —

WP WP WP — WP WP WP WP

WR WN WB WQ WK WB WN WR

Note: Before you paste an ASCII chessboard into a word processing application, use the
application’s Font command to select a non-proportional font, such as Courier, to align the
ASCII text correctly.

• Graphical Board copies the current board position (complete with graphics) to the
Windows“ clipboard. 

• Board Diagram (Chess Font) copies the current board position to the Windows“ clip-
board using the chess font.

Note: Before you paste a copied chess font board diagram into a word processing application,
use the application’s Font command to select the Chessmaster TrueType font.

To use the copy option

1. From the Edit menu, choose Copy, and then from the cascading menu, choose the
appropriate option. CHESSMASTER copies the corresponding information to the
Windows“ clipboard.

2. Open the target application and use its Paste command to insert the copied infor-
mation into the application.

3. Depending on what Copy option you used, make sure to select the appropriate font
(as specified above) in the target application.



Starting with the Tutorials
The CHESSMASTER tutorials were designed and developed exclusively for CHESSMASTER

7000 by noted author and teacher Bruce Pandolfini and GM Yasser Seirawan. These
tutorials were created specifically to help beginning, and intermediate players learn
chess and improve their game.

CHESSMASTER contains a number of tutorials expressly designed to help less-experi-
enced and beginning chess players improve their game. If you’re new to chess, you
should start with the “Your First Chess Lesson” tutorial. This tutorial explains the
basic rules and chess moves for beginning chess players. Intermediate and Advanced
players can skip this tutorial.

Once you complete all the modules under “Your First Chess Lesson” you can move
on to “Basic Chess Concepts” and “Beginning Stategies,” which introduce you to game
strategies and chess concepts that you should be aware of. These are described in
more detail in the next section.

Learning How to Think Strategically

When you start to think less about individual moves and more about sequences of
moves and board positions, you know you’ve reached the phase in chess development
called “strategic thinking.” Strategy is the grammar of chess — the glue that makes it
coherent and possible to understand the game. When you become a strategic thinker,
you move from someone who simply moves chess pieces to a chess player, someone
who thinks about the overall strategy before each move.

The first tutorial to investigate for chess strategy is “Basic Chess Concepts”.  This tuto-
rial introduces you to the basic elements of chess strategy and describes how the var-
ious pieces work together with the pawns to create good (and bad) positions. 

Learning the Whole Game — Move by Move

When you’re finished with “Basic Chess Concepts,” you’re ready for Chessmaster’s
innovative chess tutorials by celebrated chess coach and author, Bruce Pandolfini. His
tutorials start with “White’s First Move” and take you all the way through a game to
“The Endgame.” Advanced players will find Pandolfini’s tutorials useful for brushing
up on specific areas of their game.

It’s important to know that there is no “right” way to learn chess, nor is there a single
speed at which all chess players develop. The great Cuban World Champion 
José Raoul Capablanca learned chess at age four by watching his father play chess 
one week. A short time later, he was able to beat his father! On the other hand, 
the great American player Reuben Fine didn’t pick chess up until he was in his teens,
and he didn’t read a chess book until he was one of the most accomplished players 
in the country!
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THE CLASSROOM
Welcome to the CHESSMASTER 7000 Classroom, the place where you can learn about all
the different aspects involved in the game of chess. The Classroom was designed for
players of all different levels, as it provides specialized curriculums for beginners, inter-
mediate players, and advanced players. Depending on the playing level you specify, you
can choose from a wide variety of tutorials, drills, annotated games by Josh Waitzkin,
diagnostic rating exams, practice openings, and John Nunn “brain teaser” puzzles.

When you’re in the Classroom, remember that learning chess should be fun. So, relax,
take your time, and enjoy yourself!

Important: Before you use the Classroom, it’s important you review chapter 2, “Defining
Your Room Environment” on page 5. Chapter 2 shows you how to set up a room to suit your
needs and tastes, thereby allowing yourself to get the most out of Chessmaster.. By reviewing
it, you’ll learn how to design the layout of your playing area; set up sounds, narrated fea-
tures, configure your chessboard; and specify the type of chess notation you want to use.

Specifying Your Playing Level
When you first enter the Classroom, CHESSMASTER presents you with the Classroom
Curriculum dialog in which you can specify your playing level, select the curriculum
from which you want to learn, and then select the specific learning tool you want to use.

To specify your playing level

In the Classroom Curriculum dialog, click
the Beginning, Intermediate, or Advanced
tab. This tells CHESSMASTER what playing
level you’re at.

Depending on the playing level tab you
select, CHESSMASTER provides two or more of
the following curriculums — tutorials,
drills, Josh Waitzkin games, diagnostics rat-
ing exams, practice openings, and John
Nunn “brain teaser” puzzles.

If you’re beginner, you can choose a tutorial,
a drill, or an annotated game by Josh
Waitzkin. If you’re an intermediate player,
you can choose everything a beginner can
choose (only at a more intermediate level), or

you can take a rating exam or practice your openings. If you’re an advanced player, you
can skip the tutorials, annotated games, exams, and practice openings, and test your
skills by completing the advanced drills or attempting to solve the John Nunn puzzles.

Regardless of your playing level, all the CHESSMASTER curriculums (or learning tool cat-
egories) are described in detail in the following sections.



When you use a CHESSMASTER drill, you can also select the piece you want to use to
complete the drill — Queen, Rook, Bishop, Knight, or Random Piece. Where the first
four are self-explanatory, Random Piece (available only for advanced players) adds an
additional challenge to the drill, because it requires you not only complete the drill,
but also figure out which of the four pieces you’re supposed to use to solve it.

For example, suppose you select Find Mate in Two and Random Piece. In this case,
the drill would involve figuring out which of your four pieces (Queen, Rook, Bishop,
or Knight) would find the move that puts the opposing King in checkmate in your
next two moves, thus ending the game in your victory.

To select and run a drill

1. From the Classroom Curriculum dialog, specify the playing level tab that suits you
best — Beginning, Intermediate, or Advanced.

2. Click the Drills button, and then use the plus (+) and minus (-) signs to expand
and collapse the drills, so you can select the piece you want to use to solve the
selected drill.

3. Select the drill and piece you want, and then click OK. CHESSMASTER runs the select-
ed drill, which contains 10 different exercises that you can play on the chessboard.
A Drill dialog displays a brief instruction for each exercise (for example, “Find hung
piece; white Queen to move”), indicates what drill out of 10 that you’re currently
working on, and shows the elapsed time for the current exercise.

4. Click Skip to skip the current 
exercise and move on to the next, 
or click Cancel to cancel the drill. 
When you finish the drill, the Drill 
Records dialog appears indicating 
how well you did.

5. Click OK to return to the 
Classroom Curriculum dialog.

Learning from Josh Waitzkin
When you reach the point where you are beginning to take competitive chess seri-
ously, you can consider studying your game. Game study is often directed by a mas-
ter-level player (for players who are not masters) and generally requires a significant
investment in time and money. CHESSMASTER can’t replace the personalized attention
of a strong player, but with its annotated games, it allows you to approximate the
effect that a master trainer might have on your game.

CHESSMASTER provides a library of annotated games by Josh Waitzkin — the chess
celebrity featured in the noted film, “Searching for Bobby Fischer.” Fans of chess
celebrity Josh Waitzkin can truly appreciate his extensive library of annotated games.

4847

Using the Tutorials

CHESSMASTER tutorials use text, audio, and visual cues (Illustrated Voice Analysis or
IVA) to interactively lead you through each step of a lesson. Use the Next and Previous
buttons to display the next and previous screens in the tutorial. When CHESSMASTER

asks you a question, simply select the appropriate answer.

To select and run a tutorial

1. From the Classroom Curriculum dialog, click the playing level tab that suits you
best — either Beginning or Intermediate. (Advanced players can skip the tutorials.)

2. Click the Tutorials button, and then use 
the plus (+) and minus (-) signs to expand 
and collapse the tutorial topics.

3. Select the tutorial you want, and then 
click OK. CHESSMASTER starts the tutorial 
you selected.

4. Read, listen, and watch the first page of 
the tutorial, and then click Next to go to 
the next page. If the tutorial asks you a 
question, click the appropriate answer.

5. Click Cancel at any time to cancel the 
tutorial and return to the Classroom 
Curriculum dialog.

Working the Drills
The CHESSMASTER 7000 Classroom provides a series of chess drills that you can use to
enhance and improve five of the most strategic moves in the game of chess.
Depending on the playing level tab you select (Beginning, Intermediate, or Advance),
one or more of the following drills become available:

• Take the Unprotected Piece, in which you find an enemy piece that is in a position
“ripe for the taking.” In other words, a hanging piece is one that was left in or moved
to a square undefended, where it can be captured without any loss to you, the cap-
turing player.

• Find the Fork, in which find a move that results in an attack on two opposing pieces
at the same time.

• Find the Check, in which you find the move that puts the opposing King in check, so
that you can capture it on your next turn. When the opposing King is in check, your
opponent still has the opportunity to move it, so that it’s out of check.

• Find Mate in One, in which you find the move that puts the opposing King in check-
mate on your next move, thus ending the game in your victory.

• Find Mate in Two, in which you find the move that puts the opposing King in check-
mate in your next two moves, thus ending the game in your victory.



To select and take a rating exam

1. Click the Intermediate tab on the Classroom Curriculum dialog. 

2. Click the Rating Exam button, and then click the plus (+) sign to see the available
exams.

3. Select the rating exam you want, and then click OK. CHESSMASTER presents the
selected exam as a series of questions related to the area of expertise you specified.

4. For each question, click the appropriate answer, and then click Next to move to the
next question. (Click Cancel at any time to cancel the exam.) After you answer the
last question, CHESSMASTER grades the exam and displays your rating.

5. Consider your rating, and then click OK to return to the Classroom Curriculum dialog.

Practicing Your Openings
CHESSMASTER recognizes over 2200 opening book lines by name. You can practice
your openings in the CHESSMASTER Classroom by studying and doing any of these
opening book sequences.

Important: Practicing your openings involves moving pieces on the chessboard. For detailed
information on the different ways you can move pieces, see “Moving Pieces” on page 25 in
chapter 3, “The Game Room.”

To practice an opening book sequence

1. Click the Intermediate tab on the Classroom Curriculum dialog. 

2. Click the Practice Openings button, and then click the plus (+) sign to see the avail-
able practice openings.

3. Select the practice opening you want, and then click OK. The Practice dialog
appears instructing you to practice the selected opening.

4. Use the chessboard to practice the opening. CHESSMASTER lets you know when the
practice is complete.

5. Click Cancel to return to the Classroom Curriculum dialog.

Mastering Brain Teasers
In addition to tutorials, drills, rating exams, and Josh Waitzkin annotated games,
CHESSMASTER also provides a series of “Brain Teaser” puzzles from British Grandmaster
John Nunn. Not only are they fun, they also provide an outstanding way to practice
new skills and learn advanced game playing techniques. You’ll find these puzzles are
a welcome break from the endurance and tough competition that accompany the
game of chess, and by doing some of them, you’ll gain a new and different perspec-
tive on the challenges that chess offers.
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Josh provides annotations for beginners, intermediate, and advanced players.
Whatever your skill level, the Josh Waitzkin provides a great and fun way to practice
and study chess. Josh uses Illustrated Video Analysis (IVA) so that you can see and
hear the tactics and strategies behind his moves.

Note: Before you open a Josh Waitzkin game, make sure the Game Status window is open.
From the Windows menu, choose Game Status. For detailed information on the Game 
Status window, see “Using the Chessmaster Windows” on page 9 in chapter 2, “Defining Your
Room Environment.”

To watch a Josh Waitzkin annotated game

1. From the Classroom Curriculum dialog, specify the playing level tab that 
suits you best — either Beginning or Intermediate. (Advanced players can skip the
annotated games.)

2. Click the Josh Games button to see the list of annotated games.

3. Select the game you want, and then click OK. The Move List for the selected 
game appears.

4. Click Play to run the Illustrated Video Analysis (IVA) for the game. Josh talks about
and illustrates each move in the list.

5. Click Pause or Stop to stop the annotation. Pause stops the IVA in its current state
so that when you play it again, it starts where it left off. Stop rewinds the game to
the beginning of the annotation.

6. Use Move Pieces Only and Play Annotations to specify whether you want to play
the moves with or without audio.

7. Use the VCR buttons at the top of the Move List to step through the moves 
one-by-one.

8. Click the Close (X) icon in the upper-right corner of the Move List dialog to close
the game.

Note: For detailed information on the Move List and how to use it, see “Using the Move List”
on page 26. For information on printing the Move List, see “Printing the Move List and Board
Position” on page 28. Both sections are in chapter 3, “The Game Room.” 

Taking Diagnostic Rating Exams
The CHESSMASTER diagnostic rating exams let you test your knowledge in ten different
areas of expertise related to the game of chess. For example, you can find out how much
you know about openings, checkmate, endings, pawn play, typical mistakes, and more.

When you select a rating exam, CHESSMASTER presents you with a series of questions
related to the area of expertise you specified. As you work through the exam, the
questions get progressively harder. When you finish it, CHESSMASTER evaluates your
answers, and then gives you a rating. You can then use the rating to determine if
you’re an expert in the specified area, or if you need to further enhance your knowl-
edge. In short, the diagnostic rating exams can help you determine the parts of the
game on which you need to study.



THE TOURNAMENT HALL
Welcome to the Tournament Hall — the real thing — the place where everything
counts! The Tournament Hall is the place where you set up tournaments and play
rated games. Unlike unrated practice games (which you can play in the Game Room),
rated games affect your overall rating, so everything counts — there’s no taking back
moves, no advice, no coaching, and no hints. It’s between you and your computer
opponent. The winner gets a rating increase, and the loser loses rating points.

In addition to playing rated games, the Tournament Hall also let you set up round
robin tournaments, in which each player plays several other players. In round robin
tournaments, you can play with or without computer opponents.

Important: Before you play in the Tournament Hall, it’s important you review chapter 2,
“Defining Your Room Environment” on page 5. Chapter 2 shows you how to set up a 
room to suit your needs and tastes, thereby allowing yourself to get the most out of
Chessmaster. By reviewing it, you’ll learn how to design the layout of your playing area; set
up sounds, narrated features, configure your chessboard; and specify the type of chess 
notation you want to use.

Playing a Rated Game 

After you set up your room environment, using the information in chapter 2, you’re
ready to specify the details of your game. Because the primary purpose of the
Tournament Hall is to increase your rating as a chess player, you can play only rated
games in the Tournament Hall. If you want to play unrated games to enhance your
chess skills and practice your moves, you can do so in the CHESSMASTER Game Room.
For more information, see chapter 3, “The Game Room,” on page 17.

In the Tournament Hall, CHESSMASTER provides a Play Rated Game dialog that lets you
specify the game settings for a rated game. You can use the options in this dialog to:

• Choose your opponent by selecting one of the CHESSMASTER computer personalities.

• Select a time control, which determines how much time is given for individual
moves or the entire game.

• Specify your chess piece color and the side on which you want to play.

Choosing an Opponent

When you play a rated game, you can only play CHESSMASTER 7000 personalities that
match your rating. CHESSMASTER offers a gallery of opponents from which you can
choose — each with a photograph, biography, and distinct playing style. The gallery,
which is made up of over 100 different personalities, includes 80+ human-like play-
ers, 38 grandmasters, and the CHESSMASTER. If you want to play a real person, a
CHESSMASTER personality who doesn’t match your rating, or a custom personality that
you create yourself, you must play an unrated game in the Game Room. For more
information, see chapter 3, “The Game Room.”
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Puzzles like these are available in most newspapers and chess publications, so if you
find yourself hooked after solving them, there are plenty of resources to which you
can turn. So get ready to improve your chess playing skills by applying the solutions
you learn, or impress your chess-playing colleagues by solving similar puzzles found
in newspapers and other chess publications.

The John Nunn puzzles provide good analytical practice and lots of fun. By review-
ing them, you will know whether or not you’re ready to tackle them.

Important: Solving John Nunn puzzles involves moving pieces on the chessboard. For
detailed information on the different ways you can move pieces, see “Moving Pieces” on page
25 in chapter 3, “The Game Room.”

To select a puzzle to solve

1. Click the Advanced tab on the Classroom Curriculum dialog. (The John Nunn
Puzzles are not available for Beginners and Intermediate players.)

2. Click the Nunn’s Puzzles button, and then click the plus (+) sign to see the avail-
able puzzles.

3. Select the puzzle you want, and then click OK. The Tutorials dialog appears with
the puzzle you selected, and the appropriate chess pieces arranged on the chess-
board accordingly.

4. Read the commentary in the dialog, and then attempt to solve the puzzle on the
chessboard. CHESSMASTER displays a message telling you if the move you made was
correct or incorrect.

5. If the move is correct, click OK, and then click Next to move to the next puzzle. If
the move is incorrect, click OK and try again.

6. If you’re having a difficult time, click Hint to get help from CHESSMASTER.

7. Click Cancel at any time to cancel the puzzle and to close the Tutorials dialog. 

Analyzing Existing Games
When you’re in the Classroom, you can analyze existing games just like you do in the
Game Room. This is essential in gaining an understanding of your personal strengths
and weaknesses as a chess player. For more information, see “Saving and Opening
Games” on page 77 in chapter 3, “The Game Room.”

Copying the Move List and Chessboard
The Copy option on the Edit menu uses a cascading menu of additional options that
let you copy the Move List and the chessboard (in different formats) to the Windows“
clipboard. After you copy them to the Windows“ clipboard, you can insert them into
another application (such as Microsoft“ Word) using the application’s Paste command.

For more detailed information, see the corresponding section in chapter 3, “The
Game Room.”



Moves Per Minutes lets you specify the number of moves each player must make in the
number of minutes (which you also specify). This is standard for serious chess. Most
international tournaments are played at this rate. If you don’t make the required num-
ber of moves in this time, you lose. If you select this time control, type the number of
moves and minutes in the respective edit boxes.

Fischer Style lets you assign each player a specified number of minutes to complete a
game, with a certain number of bonus seconds added to the game each time a player
makes a move. If you select this time control, type the minutes and bonus seconds in
the respective edit boxes. 

Hourglass lets you assign each player a specified number of seconds per move at the
start of the game. As one player loses their time, the other player gains the same
amount of time (like an hourglass). By moving quickly, you can force your opponent
to do the same. If you select this time control, type the seconds in the Seconds edit box.

To select a time control

1. From the Game menu, choose Rated Game. The Play Rated Game dialog appears.

2. Under Time Controls, click the time control you want and type in the correspond-
ing edit box(es) using the information described above.

3. Click OK to close the Play Rated Game dialog.

Selecting Your Piece Color

When you play a rated game, CHESSMASTER doesn’t assign you a default color (like it
does when you play an unrated game). You can either specify a color, or ask
CHESSMASTER to randomly assign you a color, in which case you don’t have the advan-
tage of starting first all the time.

To select your piece color for a rated game

1. From the Game menu, choose Play Rated Game. The Play Rated Game dialog appears.

2. From the Color drop-down list, select Black or White as your piece color, or select
Play Random Color to have CHESSMASTER randomly choose your color for you

3. Click OK to close the Play Rated Game dialog.

Viewing Your Time During a Game

You can view the elapsed time for both you and your opponent during a game by
opening the Game Status window from the Windows menu. For more detailed infor-
mation on the Game Status window, as well as the other window aids that
CHESSMASTER provides, see “Using the CHESSMASTER Windows” on page 9 in chapter 2,
“Defining Your Room Environment.” Note that when you play a rated game in the
Tournament Hall, not all CHESSMASTER windows are available to you. Also remember
that when you play a rated game — a real chess game — there are no hints, no advice,
and no coaching.
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To choose an opponent for a rated game

1. From the Game menu, choose 
Rated Game. The Play Rated Game 
dialog appears with your rating at 
the upper-left, and your opponent’s 
rating at the upper-right.

2. From the opponent drop-down list, 
select the computer personality you 
want to play.

3. To view the details of each person-
ality, click Personality to d i s p l a y  
the Select Personality dialog.

• Scroll through the list to view the
available personalities. Use the 
Filters tab to specify the criteria 
you want your opponent to meet 
and to filter the list accordingly. 
The Custom Players and Rating 
check boxes aren’t available for 
rated games.

• Choose an opponent from the 
list and click the Info tab to view 
the biography and playing style of 
that opponent.

• Click OK to return to the Play 
Rated Game dialog.

4. Click OK again to close the Play Rated Game dialog.

Selecting a Time Control

Rated games offer a subset of the unrated-game time controls. When you set up a
rated game, you can choose one of the following:

Minutes Per Game lets you specify the number of minutes each player has to complete
the game. If you specify under 15 minutes, you are playing “blitz chess,” which is one
of the most popular forms of chess. More and more tournaments are being played at
these time controls, including the Professional Chess Player Association’s Grand Prix
circuit. If you select this time control, type the number of minutes in the Minutes edit
box.



Pausing a Game

Given the depth of strategy, the required thinking, and the intense concentration — 
all of which play a role in the game of chess — it is not uncommon for a chess game
to last an extended period of time. Given this, CHESSMASTER lets you pause a game 
at any time.

To pause a game

1. From the Actions menu, choose Pause.

2. Click OK to resume the game.

Adjourning a Game

CHESSMASTER lets you suspend, or adjourn, a game so that you can continue it at a later
time. When you adjourn a game, CHESSMASTER retains the position of both black and
white pieces, as well as the elapsed game time. You can only adjourn a game when it
is your turn to move.

To be fair to both players, Chessmaster asks you to make a sealed move before you
adjourn the game. CHESSMASTER resumes an adjourned game by starting with your
sealed move, so the sealed move isn’t revealed to your opponent until the game resumes. 

To adjourn a game

1. From the Actions menu (or right-click menu), choose Adjourn. The Adjourn Game
dialog appears prompting you to make a sealed move.

2. Make the next move in your game. The File Save dialog appears, so you can save
your game. 

3. Specify the folder, file type, and file name to which you want to save the game. You
should always save adjourned games as CHESSMASTER Game (.cmg) files.

4. Click Save. CHESSMASTER saves the adjourned game to the specified location and 
file name.

You can resume an adjourned game by opening the corresponding CHESSMASTER Game
(.cmg) file. When you open the game, CHESSMASTER reveals your sealed move to your
opponent, and your game begins from where you left off.

To resume an adjourned game

1. From the File menu, choose Load > Load Adjourned Game. The File Open 
dialog appears.

2. From the Look In drop-down list, select the folder that contains the adjourned game.

3. From the File of Type drop-down list, select Chessmaster Games (.CMG). All the
Chessmaster Game (.cmg) files appear.

4. Select the game, and then click Load. CHESSMASTER opens the game and resumes it
by making your sealed move.
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Moving Pieces
After you specify the details of your rated game, you are ready to play. A game begins
as soon as you or your opponent makes the first move. If you are White, you need to
make the first move. If your opponent is White, you must wait until your opponent
moves.

You can move pieces using the mouse by clicking and dragging, or using your key-
board by typing each move in the specified notation.

Moving Pieces with the Mouse

Using the mouse is the easiest and most common way to move your pieces.

To move a piece with your mouse

1. Place the pointer over the chessboard. The pointer changes to a hand.

2. Click the piece you want to move and drag it to its destination square. The hand
grabs the piece as you drag it.

Note: If you’re having difficulty grabbing a chess piece, make sure the dot on the index finger
of the hand is inside the square of the piece you want to move.

Two options on the Board Settings dialog — Quick Entry and Sliding Pieces — let you
determine how you and your opponent move pieces on the board. For more infor-
mation, see “Using the Board Settings Dialog” on page 13 in chapter 2, “Defining Your
Room Environment.”

Moving Pieces with the Keyboard

You can use the keyboard to move pieces by typing the moves in the current notation.
For example, if the current notation is Algebraic, and you want to move a pawn from
d2 to d4, you simply type d4.

To move a piece with the keyboard

1. Move the pointer over the square of the piece you want to move.

2. Type the destination square using the current notation and press Enter. 

Note: For more information on chess notation, see “Specifying Chess Notation” on page 15
in chapter 2, “Defining Your Room Environment.” 

Pausing or Ending a Game
The Tournament Hall provides an Actions menu that lets you:

• Pause a game for a quick break.

• Adjourn a game so you can continue it later.

• Offer a draw when it seems unlikely that you or your opponent can win.

• Resign from a game when it seems unlikely that you yourself will win.



When you create and hold a CHESSMASTER tournament, you:

• Run the tournament wizard to define the tournament, and then save the tournament
to disk.

• Schedule the tournament and watch the rounds.

• View and print the tournament results.

• Open an existing tournament you previously saved.

Running the Tournament Wizard

When you create a tournament in CHESSMASTER, the first thing you do is run the tour-
nament wizard to create it, and then CHESSMASTER prompts you to save the tourna-
ment to disk. When you run the wizard, CHESSMASTER prompts you to set the tourna-
ment type, participants, number of rounds, and time control.

To create a tournament and save it to disk

1. From the Game menu, choose Tournament > Create. The Create Tournament
Wizard appears prompting you to specify the type, number of rounds, and whether
you want CHESSMASTER to rate the participants.

• Specify a time control for the Tournament  
game. (See “Selecting a Time Control” on 
page 22).

• In the # of Rounds box, type the number of 
rounds. CHESSMASTER displays the number of 
participants allowed, depending on the 
number of rounds you specify.

• Check the Rated Tournament check box if 
you want the tournament results to affect the 
participants’ overall rating.

2. Click Next. The Create Tournament Wizard prompts you to specify the tournament
participants. The right column displays the available computer opponents, and the
left column will display the participants you want to add to this tournament.

3. From the right column, select the opponent you want to add as a participant, 
and click >>. The selected opponent appears in the left list of tournament partici-
pants. Repeat this step for every opponent you want to add. To see the rating, 
playing style, and biography on each available opponent, click the Personality but-
ton to display the Select Personality dialog (described under “Choosing an
Opponent” on page 18).
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Offering a Draw

If it seems unlikely that you or your opponent can win the game, CHESSMASTER lets
you offer a draw. CHESSMASTER won’t agree to a draw if it believes it has even the slight-
est advantage — even if the position is objectively drawn. Also, CHESSMASTER won’t
agree to a draw early in the game, even if it has a technical disadvantage. In short, you
should only offer a draw if you’re convinced that you have an advantage, or that the
current position has no play at all.

To offer a draw

1. From the Actions menu (or right-click menu), choose Offer Draw. If CHESSMASTER

accepts the draw, a message appears indicating its acceptance. If CHESSMASTER

declines the draw, a message appears telling you to play on.

2. Click OK to end the game or continue the game respectively. 

If CHESSMASTER declines the draw, and you still want to end the game, you can resign
from the game by choosing Resign from the Actions menu or right-click menu.

Resigning from a Game

If you’re getting frustrated and it seems unlikely that you can win, CHESSMASTER lets
you resign from the game at any time

To resign from a game

1. From the Actions menu (or right-click menu), choose Resign. A message appears
asking if you want to resign.

2. Click Yes.

Copying the Move List and Chessboard
The Copy option on the Edit menu uses a cascading menu of additional options that
let you copy the Move List and the chessboard (in different formats) to the clipboard.
After you copy them to the clipboard, you can insert them into another application
(such as Microsoft® Word) using the application’s Paste command.

For more detailed information, see the corresponding section in chapter 3, “The
Game Room.”

Holding Tournaments

Have you ever wondered how the first generally-acknowledged world champion —
the great nineteenth-century American Paul Morphy — would fare against the twen-
tieth-century American world champion Bobby Fischer? Or how Garry Kasparov
would fare against Bobby Fischer? If you think of a match that includes two grand-
masters from two different eras, CHESSMASTER 7000 can simulate their play. In fact, you
can set up a tournament and watch eight grandmaster personalities battle it out! You
can even include yourself as a contender, and see how you do.



Viewing and Printing Tournament Results

When all tournament rounds are complete, the Tournament Results dialog appears dis-
playing the wins, losses, draws, total game points for each round, and the overall score.

To view and print the tournament results

1. From the Game menu, choose Tournament > View Results (if the Tournament
Results dialog is not already displayed).

2. Click Games. The Games Played dia
log appears with a summary of each 
completed round.

3. Click OK to return to the 
Tournament Results dialog, and 
then click OK again when you’re 
done reviewing the results.

4. From the File menu, choose Print 
Tournament Results. The Print dia
log appears.

5. Specify the number of copies you want to print and any other settings you want,
and then click OK. CHESSMASTER prints the tournament results using the settings
you specified.

Opening an Existing Tournament

CHESSMASTER lets you open an existing tournament you previously saved to view and
print the results of a completed match, re-watch a tournament, or start one you
haven’t seen yet.

To open an existing tournament

1. From the Game menu, choose Load > Load Tournament. The File Open dialog
appears.

2. In the Look In box, specify the folder that contains the tournament (.cmt) file you
want to open. 

3. From the File of Type drop-down list, select Chessmaster Tournaments, and from
the Open As drop-down list, select Auto.

4. Select the tournament file you want to open. The corresponding file name appears
in the File Name box.

5. Click Load. The Tournament Schedule dialog appears.

6. Start a round using the procedure outlined under “Scheduling a Tournament” on
page 59. To print and review the tournament results, see the previous section.
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4. Click Next. The Create Tournament Wizard prompts you to add any human players
to the tournament list of participants, using the same procedure outlined in step 3.

5. Click Finish. CHESSMASTER displays the File Save dialog, so you can save the tour-
nament to disk.

6. In the Save In box, specify a location for the saved tournament; in the File Name
box, accept the default name or type the name you want; in the Save as Type box,
accept Chessmaster Tournaments, and then click Save. CHESSMASTER saves the tour-
nament as a .cmt file to the location, file name, and type you specified, and then
displays the Tournament Schedule dialog, in which you can select and start the
rounds of the tournament. The Tournament Schedule dialog is described in the
next section.

Scheduling a Tournament

CHESSMASTER provides a Tournament Schedule dialog that lets you schedule tourna-
ments and start a round. This dialog appears after you save a tournament, load a tour-
nament game that you haven’t started yet, or after a round in a round robin match ends.

To schedule a tournament

1. If the Tournament Schedule dialog isn’t open, choose Tournament > Schedule from
the Game menu.

2. Select a round, and do one of the following:

• Click Select if the tournament includes human players. Select requires that you
manually start all the rounds in the tournament. When a round ends, the
Tournament Schedule dialog reappears, prompting you to select the next round.
You must monitor each match if you’re running a round robin tournament.

• Click Auto if the tournament includes only computer players. In this case,
CHESSMASTER schedules and plays the tournament rounds for you.

In either case — if you click Select or Auto — the Tournament Schedule dialog clos-
es, and the selected round begins. White moves first.

You can schedule a tournament at any time by choosing Tournament > Schedule from
the Game menu. However, this option is available only if you create or load a tour-
nament during the current CHESSMASTER session.



THE LIBRARY
Welcome to the CHESSMASTER 7000 Library, the place where you can complete 
extensive research on the game of chess. You can study and browse the Opening 
Book Reference, which lists all the known opening variations, as well as use the
Opening Book Editor to edit your own opening books or create new ones. The Library
also contains over 700 of the most famous and note-worthy classic chess games
played throughout history; for example, Evans vs. Bisguer, the 1959 USA
Championship Game in New York City; or Tsheshkovsky vs. Lutikov, the 1969 USSR
Championship in Moscow.

You can simply choose the classic game you want, and then sit back and relax while
you watch, listen, and learn from the Grandmasters of chess, as they annotate each
move and provide tactical and strategic commentary on the game of your choice. You
can also study the comprehensive CHESSMASTER glossary to brush up on your chess
terminology and enhance your knowledge and expertise. So take a break from the
intensity of the game, and take some time out for yourself to study and learn in the
Library. See how you can quickly become an even better chess player!

Important: Before you begin studying in the Library, it’s important you review chapter 2,
“Defining Your Room Environment” on page 5. Chapter 2 shows you how to set up a room
to suit your needs and tastes, thereby allowing yourself to get the most out of Chessmaster.
By reviewing it, you’ll learn how to design the layout of your playing area; set up sounds and
narrated features; select and configure your chessboard; specify the type of chess notation you
want to use; and use the Chessmaster windows to make the learning process quick and fun.

Using the Opening Book Reference
An opening book is a repertoire of opening moves and counter moves that a computer
player refers to during a game. CHESSMASTER stores its opening books as .obk files.
Most of the Grandmasters of chess have documented their opening moves and
counter moves, which CHESSMASTER has compiled into a single Master Opening Book
called Mentor.obk. You can think of the Master Opening Book as Chessmaster’s ency-
clopedia of known opening moves. When you’re in the Library, you can open the
Master Opening Book at any time and use it as a source of reference.

To get the most out of the Opening Book Reference, you should use it in conjunction
with the Game Status window and Annotation window, both of which you can open
from the Windows menu. The Game Status window lets your scroll through the
moves in the Master Opening Reference using the Move List and VCR buttons. The
Annotation window lets you review and listen to annotations on each individual
move. For more detailed information, see “Using the CHESSMASTER Windows” on page
9 in chapter 2, “Defining Your Room Environment.”
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Suspending Tournaments

CHESSMASTER automatically saves the tournament results at the end of each match. If
you want to suspend, or adjourn, the current tournament and resume it later, you can
do so using the Adjourn option in the Actions menu, provided that the tournament
uses a human participant.

Note: You can only adjourn tournaments that use one or more human participants.

When you adjourn a tournament, CHESSMASTER retains the position of both black and
white pieces, as well as the elapsed game time. You can only adjourn a tournament
when it is a human player’s turn to move.

To be fair to all players, CHESSMASTER asks the human player to make a sealed move
before adjourning the tournament. CHESSMASTER resumes an adjourned tournament
by starting with the sealed move of the human player, so the sealed move isn’t
revealed until the tournament resumes.

To adjourn the current tournament

1. From the Actions menu (or right-click menu), choose Adjourn. The Adjourn Game
dialog appears prompting you to make a sealed move.

2. Make the next move in your game. The File Save dialog appears, so you can save
the adjourned tournament. 

3. Specify the folder, file type, and file name to which you want to save the tourna-
ment. You should always save adjourned tournaments as CHESSMASTER Tournament
(.cmt) files.

4. Click Save. CHESSMASTER saves the adjourned tournament to the specified location
and file name.

You can resume an adjourned tournament by opening the corresponding CHESSMASTER

Tournament (.cmt) file. When you open the tournament, CHESSMASTER reveals the
sealed move of the human player, and the tournament begins from where it left off.

To resume an adjourned tournament, use Load > Load Tournament in the File menu
to open the corresponding .cmt file. For detailed information, see the previous sec-
tion, “Opening an Existing Tournament.”



• Weight displays one of four values (0, 25, 50, or 100) which indicates the percent-
age of time that the selected move is used. For example, suppose the current open-
ing book contains three opening moves — e2-e4, b2-b4, and d2-d3 — and they
each have corresponding Weight values of 25, 50, and 100, respectively. In other
words, the weight of e2-e4 is 25, b2-b4 is 50, and d2-d3 is 100.

To calculate the probability of using a specific opening line, CHESSMASTER adds 
the weight values of all the moves combined — which in this case is 175 — and
then interprets the individual percentages accordingly. Given this, the probability of 
e2-e4 occurring is 25 times out of 175 possible (or 14% of the time); the probabil-
ity of b2-b4 is 50 out of 175 (or 28%); and the probability of d2-d3 is 100 out of 
175. (58%) If a given move has a Weight of 0, then the probability of that move 
being used is zero.

Using the Opening Book Editor
In addition to the Opening Book Reference, the Library also provides an Opening Book
Editor that lets you create a new opening book from scratch by either specifying the
opening moves you want to include, or using an existing opening book as a base. You
can also edit existing opening books, and then save them to reflect the new changes.

To create a new opening book from scratch

1. From the Opening Book menu, choose 
Edit Opening Book. An empty 
Opening Book dialog appears in 
which you can start creating a new 
opening book.

2. Using the chessboard, make the first 
opening move. The opening move 
appears (in the current notation) in the 
Opening Moves window at the bottom 
of the dialog. It also appears in the 
Moves box as the first move in the cor
responding moves line.

3. If you want, type a variation name in the Variation box for the opening move.

4. From the Weight drop-down list, choose a Weight value for the opening move. (For
detailed information on Weight values, see the previous section.)

5. Make the first counter move. CHESSMASTER updates the Opening Moves window
and the Moves box accordingly.

6. Repeat steps 3 and 4 for the first counter move, which will appear in the second
column (1. …) of the Opening Moves window.

7. Continue this process to specify the entire moves line for the first opening.
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To use the Opening Book Reference

1. From the Opening Book menu, choose Opening Book Reference. CHESSMASTER dis-
plays a message indicating that it’s loading the opening book moves, and then it
opens the Opening Book dialog with Mentor.obk, the Master Opening Book.

2. Use the Opening Moves window at the 
bottom of the dialog to review the possible 
opening moves and counter moves. (The 
Opening Moves window and the other 
components of the Opening Book dialog 
are described in the next section.)

3. When you’re done using the Opening 
Book Reference, click the Close icon (X) in 
the upper-right corner of the dialog.

The Opening Book Dialog

The Opening Book dialog consists of four boxes at the top — Variation, Moves, ECO,
and Weight — as well as an Opening Moves window at the bottom. 

The Opening Moves window displays the opening moves of the current opening book.
The column titles indicate the move number for each player. For example, “1.” repre-
sents White’s first move, and “1. …” represents Black’s first counter move. “2.” repre-
sents White’s second move, “2. …” represents Black’s second counter move, and so on.

You can click the plus (+) nodes in the first column (which lists the opening moves
for the White player) to display the next column, which lists all the possible counter
moves for the Black player. As you continue to click the plus (+) nodes in each col-
umn, the Opening Moves tree begins to expand to show all the possible move lines
for each opening.

Once you expand the Opening Moves tree, you can use either the mouse or the arrow
keys (on your keyboard) to select the individual moves within the tree, and you can
use the minus(-) nodes to collapse the tree. The boxes above the Opening Moves win-
dow update dynamically as you select different moves in the Opening Moves tree.
These boxes are described below: 

• Variation displays the variation name (if any) of the selected opening move or
counter move.

• Moves displays the moves line, which consists of the opening move and counter
moves, up to and including the selected move.

• ECO displays the opening code (if any) of the selected move. The ECO code is a con-
vention used in professional chess which CHESSMASTER supports. It appears for infor-
mational purposes only.



• If you want to clear the Opening Book dialog, so you can start over again or create
a new opening book from scratch, choose New Opening Book from the File menu.
If you haven’t saved the current opening book, CHESSMASTER asks you if you want to
save it. Click Yes to save it or No to cancel it. If you choose to save the new open-
ing book, CHESSMASTER displays the File Save dialog, which is described above.

• If you want to base a new opening book on an existing opening book (or you want
to simply edit an existing opening book), you can load the one you want by choos-
ing Load Opening Book from the File menu. This displays the File Open dialog from
which you can choose an opening book in Chessmaster’s .obk format. Click Load to
open the selected .obk file into the Opening Book dialog. If an opening book already
exists in the Opening Book dialog, and you haven’t saved it, CHESSMASTER prompts
you to save it. You can then edit the existing opening book, using the information
in the previous sections.

• You can also open an existing opening book by choosing Import PGN File from the
File menu. Import PGN File displays the File Open dialog from which you can choose
an opening book in Portable Game Notation (.pgn) format. Click Load to open the
selected .pgn file into the Opening Book Editor. If an opening book already exists, and
you haven’t saved it, CHESSMASTER prompts you to save it. If the PGN file contains more
than one game, CHESSMASTER loads all the openings from all the games. You can then
edit the existing openings, using the information in the previous sections.

Studying a Classic Game
CHESSMASTER provides a library of 700 classic games that you can study and analyze
to enhance your playing skills and make you a more knowledgeable chess player.
Grandmasters including GM Larry Evans and GM Yasser Seirawan annotate these
classic games, which range from year 1790 to 2001.

To open a classic game

1. From the Game menu, choose Select Classic Game. The Load Classic Game dialog
appears listing all the CHESSMASTER classic games in chronological order.

2. Select the classic game you want to 
open, and then click OK. 
CHESSMASTER opens the selected game 
on the chessboard.

3. If the Move List isn’t open, choose 
Game Status from the Windows 
menu, and then use the VCR buttons 
to scroll through each move of 
the game.

4. If the Annotation window isn’t open, 
choose Annotation from the Windows 
menu. The Annotation window lets

you review and listen to comments on a given move and review the analysis of the over-
all game. For more information, see “Using the CHESSMASTER Windows” on page 9 in
chapter 2, “Defining Your Room Environment.”
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8. To build your Opening Moves tree, create a second counter move to the first open-
ing move by selecting the first opening move in the tree. This returns the chessboard
to that position, so that you can start building the moves line for the next possible
counter move. (Note that the chessboard is like a mirror of the Opening Moves tree.)

9. Repeat steps 5 through 8 until you specify all the possible move lines for your 
first opening.

10. Continue this process to complete your opening book. As your tree expands to
the left, a hierarchy develops that includes “parent” moves, “children” moves, and
“sibling” moves. (“Sibling” moves are moves that appear in the same column and
share the same “parent”.) You can use the mouse or the arrow keys to select indi-
vidual moves in the hierarchical tree, so you can modify or delete them.

As you create your new opening book, review the considerations outlined in the
next section. They show you how you can delete a move, save the current open-
ing book, clear the Opening Book dialog in case you want to start over again, base
a new opening book on an existing one, and edit an existing opening book.

11. To close the Opening Book dialog, click the Close icon (X) in the upper-right cor-
ner of the dialog. If you haven’t saved the current opening book, CHESSMASTER

asks if you want to save it. Click Yes to save it or No to cancel it.

Note: If you choose to save the new opening book, Chessmaster displays the File Save dialog,
which is described in the next section.

Things to Consider

When you’re creating a new opening book, consider the following:

• Opening moves and counter moves are specified in the current chess notation. 
For detailed information on the available chess notations and how to use them, 
see “Specifying Chess Notation” on page 15 in chapter 2, “Defining Your 
Room Environment.”

• To get the most out of the Opening Book dialog, you should use it in conjunction
with the Game Status window and Annotation window, both of which you can open
from the Windows menu. The Game Status window lets your scroll through the
moves in your opening book using the Move List and VCR buttons. The Annotation
window lets you review and listen to annotations on each individual move. For
more detailed information, see “Using the CHESSMASTER Windows” on page 9 in
chapter 2, “Defining Your Room Environment.”

• To delete a move from an opening book, select the move you want to delete from
the Opening Moves window, and then press the Delete Key.

Important: When you delete a move, note that CHESSMASTER deletes all its “children”
moves as well.

• To save the current opening book, choose Save from the File menu. CHESSMASTER

displays the File Save dialog. Type a name for the opening book in the File Name
box, specify a folder in the Save In box, specify Chessmaster Opening Book (.OBK)
in the Save As box, and then click Save. CHESSMASTER saves it as a .obk file using the
folder and name you specified.



Learning Chess
The Kids Room offers a wide variety of ways in which you can learn about the game
of chess and how to play it quickly and easily. For example, you can:

• Work through the tutorials to learn the chess basics.

• Challenge yourself and test your skills by completing the drills.

• Watch, observe, and learn from the annotated games by Josh Waitzkin, world-renowned
chess player and subject of the popular movie, “Searching for Bobby Fischer.”

While you’re using these tutorials, drills, and annotated games, remember that learn-
ing chess should be fun. So, relax, take your time, and enjoy yourself!

Using the Tutorials

The Kids Room tutorials were designed exclusively for CHESSMASTER kids by author
and chess coach Bruce Pandolfini and former American Champion and International
Grandmaster Yasser Seirawan. (Yasser Seirawan is one of the most successful tourna-
ment players in the world!) These tutorials were created specifically to help you learn
the game of chess quickly and improve your playing skills.

It’s important to know that there is no “right” way to learn chess, nor is there a single
speed at which all chess players develop. The great Cuban World Champion José Raoul
Capablanca learned chess at age four by watching his father play chess one week. A
short time later, he was able to beat his father! On the other hand, the great American
player Reuben Fine didn’t pick chess up until he was in his teens, and he didn’t read a
chess book until he was one of the most accomplished players in the country!

CHESSMASTER tutorials use text, audio, and visual cues to interactively lead you
through each step of a lesson. Use the Next and Previous buttons to display the next
and previous screens in the tutorial. When CHESSMASTER asks you a question, simply
select the appropriate answer.

Important: To run a tutorial, make sure you insert Disc 2 in your CD-ROM drive.

To select and run a tutorial

1. From the Teaching menu, choose 
Tutorials. The Classroom 
Curriculum dialog appears with 
the Tutorials button selected.

2. Use the plus (+) and minus (-) 
signs to expand and collapse the 
tutorial topics.

3. Select the tutorial you want, 
and then click OK. CHESS-
MASTER starts the tutorial 
you selected.
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Saving a Classic Game

When you study and analyze a classic game in the Library, you can save it in Portable
Game Notation (.pgn) format to any location on your hard disk. By having it readily
available, you can quickly access it any time you want, or perhaps send it to a friend
who enjoys chess as much as you do!

Note: Before you save a game, we recommend you create a My Games folder (under the
Chessmaster 7000 folder) for the games you want to save.

To save a classic game

1. From the File menu, choose Save. The File Save dialog appears.

2. From the Save In drop-down list, specify the folder where you want to save your game.

3. From the Save As drop-down list, select Portable Game Notation (.PGN).

4. In the File Name box, type a name for the game you’re saving.

5. Click Save. CHESSMASTER saves the game to the specified folder, file type, and name.

Copying the Move List and Chessboard
The Copy option on the Edit menu uses a cascading menu of additional options that
let you copy the Move List and the chessboard (in different formats) to the clipboard.
After you copy them to the clipboard, you can insert them into another application
(such as Microsoft® Word) using the application’s Paste command.

For more detailed information, see the corresponding section in chapter 3, “The
Game Room.”

THE KIDS ROOM
Welcome to the CHESSMASTER 7000 Kids Room, the one room that is specifically
designed just for kids. It’s the one-stop place where kids of all ages can enjoy the game
of chess without having to enter any of the other CHESSMASTER rooms. In the Kids
Room you can do a little of everything that CHESSMASTER 7000 has to offer. You can
learn chess basics; you can practice what you’ve learned using the simplified chess
drills; you can play chess against computerized kid-like opponents; and you can earn
Master Class points for the lessons you complete and the opponents you beat — all
within a kid-friendly environment! So let the CHESSMASTER 7000 Kids Room turn you
into the chess player that you’ve always dreamed you’d be!

Important: Before you play in the Kids Room, it’s important you review chapter 2, “Defining
Your Room Environment” on page 5. Chapter 2 shows you how to set up a room to suit your
needs and tastes, thereby allowing yourself to get the most out of Chessmaster. By reviewing
it, you’ll learn how to design the layout of your playing area; set up sounds and narrated fea-
tures; use the help windows that provide visual aids while you play, practice, or learn chess;
and pick out the chessboard and pieces you want to use.



3. Click Play to run the voice for the game. Josh talks about and illustrates each move
in the Move List.

4. Click Pause or Stop to stop the annotation. Pause stops the voice in its current state
so that when you play it again, it starts where it left off. Stop rewinds the game to
the beginning.

5. Use Move Pieces Only and Play Annotations to determine whether you want to play
the moves with or without audio.

6. Use the VCR buttons at the top of the Move List to step through the moves one-
by-one.

7. Click the Close (X) icon in the upper-right corner of the Move List dialog to close
the game.

Note: For detailed information on the Move List and how to use it, see “Using the Move List”
on page 26. For information on printing the Move List, see “Printing the Move List and Board
Position” on page 28. Both sections are in chapter 3, “The Game Room.” 

Playing a Practice Game
After you set up your room environment, using the information in chapter 2, and
have completed some of the tutorials, drills, and Josh Waitzkin games, you’re ready
to play a game. If you want to play a practice game, in which you can get advice and
help from CHESSMASTER, do things like take back your moves, as well as see what your
opponent is thinking, you’ll want to play an unrated game.

Note: If you want to play a rated game — a real game that counts and affects your chess
rating — see “Playing a Real Game” on page 73.

For unrated games, or practice games, CHESSMASTER provides a Set Up Game feature
in the Game menu that lets you:

• Choose your opponent by selecting one of the CHESSMASTER computer opponents, or
typing in a human player, such as your friend.

• Select a time control, which determines how much time you want to give for indi-
vidual moves or the entire game.

• Choose your chess piece color and the side on which you want to play.

• Set the rules of the game, which include Touching and Blindfold Play.

Choosing an Opponent

The Kids Room provides some computer opponents that you can choose from. Each
computer opponent comes with a picture and some text that you can read to learn
about the opponent.
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4. Read, listen, and watch the first page of the tutorial, and then click Next to go to
the next page. If the tutorial asks you a question, click the appropriate answer.

5. Click Cancel at any time to cancel the tutorial.

Working the Drills
The Kids Room provides some chess drills that you can use to enhance and improve
your strategic moves in the game of chess. When you use a drill, you can also select
the piece you want to use to complete the drill.

To select and run a drill

1. From the Teaching menu, choose Drills. The Classroom Curriculum dialog appears
with the Drills button selected.

2. Select the drill you want, and then click the plus (+) sign, so you can select the
piece you want to use to solve the selected drill.

3. Select the piece you want, and then click OK. CHESSMASTER runs the selected drill,
which contains several exercises that you can play on the chessboard. A Drill dia-
log displays a brief instruction for each exercise, indicates the drill that you’re cur-
rently working on, and shows the elapsed time for the current exercise.

4. Click Skip to skip the current exercise and move on to the next, or click Cancel to
cancel the drill. When you finish the drill, the Drill Records dialog appears indi-
cating how well you did.

5. Click OK to close the Drill Records dialog.

Learning from Josh Waitzkin
When you reach the point where you’re beginning to take chess seriously, you can con-
sider studying your game. Game study is often directed by a master-level, profession-
al chess player. CHESSMASTER provides a library of annotated games by Josh Waitzkin
— the chess celebrity and subject of the popular movie, “Searching for Bobby Fischer“. 

With Josh Waitzkin by your side, you can practice and study chess, and have fun
while doing it! Josh uses his real-life voice so that you can see and hear the tactics and
strategies behind his moves.

Note: Before you open a Josh Waitzkin game, make sure the Game Status window is open.
From the Windows menu, choose Game Status. For detailed information on the Game Status
window, see “Using the Chessmaster Windows” on page 9 in chapter 2, “Defining Your Room
Environment.”

To watch a Josh Waitzkin annotated game

1. From the Teaching menu, choose Josh Waitzkin Games. The Classroom
Curriculum dialog appears with the Josh Games button selected.

2. Select the game you want, and then click OK. The Move List for the selected game
appears in the Game Status window.



2. Click the Time Controls tab.

3. Click either Same Time Controls 
or Separate Time Controls to give 
both players the same time or 
different amounts of time. If you 
click Separate Time Controls, two 
sets of time boxes appear; one for 
each player. This is useful if you 
want more time than your 
opponent does.

4. From the drop-down list, select 
one of the following time controls: 

Moves/Minutes lets you type the number of moves per minutes each player needs to
make. Simply type the number of moves and minutes in the boxes.

Seconds Per Move lets you type the number of seconds each player has to make a
move. This time control instructs the players to spend a certain number of seconds
thinking about each move. If you select this time control, type the number of seconds
in the Seconds Per Move box.

Minutes Per Game lets you type the number of minutes each player has to complete the
game. If you select this time control, type the number of minutes in the Minutes box.

Fischer Style lets you assign each player a certain number of minutes to complete 
a game, with a certain number of bonus seconds added to the game each time a 
player makes a move. If you select this time control, type the minutes and bonus 
seconds in the boxes. 

Hourglass lets you assign each player a specified number of seconds per move at the
start of the game. As one player loses their time, the other player gains the same
amount of time (like an hourglass). By moving quickly, you can force your opponent
to do the same. If you select this time control, type the seconds in the Seconds Per
Move box.

Infinite Time doesn’t set any time limitations on your game. Players can take as long as
they want, and the game lasts as long as it takes. If you’re playing against a computer
opponent, it might take a long time to move. In this case, choose Force Move from the
Actions menu. Remember, the longer you let the computer think, the better it plays!

Equal Time forces the computer to match the time you take to make a move, based on
the average time per move. For example, if you complete five moves in 50 seconds,
the computer will take approximately 10 seconds to make its next move. In short, 
if you move slowly, the computer moves slowly; if you move quickly, so does the
computer. This time control doesn’t apply to human players.
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To choose an opponent for an unrated game

1. From the Game menu, choose Set Up 
Game. The Set up Game Details 
dialog appears displaying the players 
above and below the chessboard. 
You are white (on bottom), and your 
opponent is black (on top).

2. The Computer button next to 
the Top opponent box, and then 
click Personality. The Select 
Personality dialog appears.

3. Scroll through the list to view the 
available personalities. Use the 
Filters tab to specify the criteria 
you want your opponent to meet 

and to filter the list accordingly. Use the Info tab to view the biography and playing
style of the current opponent.

4. Select the opponent you want to play, then click OK. The name of the opponent
you selected appears in Top opponent box of the Set up Game Details dialog.

5. Click OK to close the Set up Game Details dialog.

You can also play a human player. For example, you might want to play your 
brother, your sister, your parent, or a friend.

To pick a human player as your opponent

1. From the Game menu, choose Set Up Game. The Set up Game Details dialog
appears displaying the players above and below the chessboard. By default, you are
white (on bottom), and your opponent is black (on top).

2. Click the Human button next to the Top opponent box.

3. Type the name of your opponent in the opponent box and click OK.

Setting the Time

The amount of time you give yourself and your opponent to complete a game (or a
move) is very important in the game of chess. 

To select a time control

1. From the Game menu, choose Set Up Game. The Set up Game Details dialog appears.



In a real game, the winner gets a rating increase, and the loser loses rating points. To
see your overall rating, choose Player Progress from the Windows menu. For detailed
information on the Player Progress window, see “Using the Player Progress Window”
on page 75. 

You set up a rated game in a similar way that you set up an unrated game. From the
Game menu, choose Play Rated Game. You can use the information in the previous
sections for an unrated game to choose your opponent, select a time control, and
choose your piece color. The only difference is that you don’t have access to all the
time controls that you do in a unrated game, and when you select a piece color, you
can choose Play Random Color to have CHESSMASTER choose your piece color for you.
Also, a rated game doesn’t allow special rules, such as Touching and Playing
Blindfolded. Other than these differences, setting up a rated (real) game is very simi-
lar to setting up an unrated (practice) game.

Moving Pieces
After you set up a rated or unrated game, you are ready to play. A game begins as soon
as you or your opponent makes the first move. If you are White, you need to make
the first move. If your opponent is White, you must wait until your opponent moves.
You can move pieces using the mouse by clicking and dragging. 

To move a piece on the chessboard

1. Place the pointer over the chessboard. The pointer changes to a hand.

2. Click the piece you want to move and drag it to its destination square. The hand
grabs the piece as you drag it. If you make a wrong move CHESSMASTER returns the
piece to its original square, and if Illegal Move Commentary is on in the Sounds
dialog, CHESSMASTER tells you why the move is wrong. 

3. If you make a mistake and you’re playing an unrated game, choose Takeback Move
from the Actions menu. (This option is not available if you’re playing a rated game.)

Note: If you’re having difficulty grabbing a chess piece, make sure the dot on the index finger
of the hand is inside the square of the piece you want to move.

Two options on the Board Settings dialog — Quick Entry and Sliding Pieces — let you
determine how you and your opponent move pieces on the board. For more infor-
mation, see “Using the Board Settings Dialog” on page 13 in chapter 2, “Defining Your
Room Environment.”

CHESSMASTER records each move you and your opponent make during a game. It
records the moves in the Move List of the Game Status window, which you can access
from the Windows menu. For more information on the Move List, see “Using the
Move List” on page 26 in chapter 3, “The Game Room.”
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Choosing Your Piece Color

CHESSMASTER automatically assigns you as the Bottom player with white chess pieces.
You can change side you play on, as well as the color of your pieces.

To change your side and piece color

1. From the Game menu, choose Set Up Game. The Set up Game Details dialog appears.

2. Make sure the Colors tab is displayed

3. Clear the [Your Name] Plays From Bottom box, and then click the Rotate Board
button twice. You are now the Top player with the black chess pieces.

When you switch sides, you interrupt the computer’s thinking. This means that if
you’re playing the computer, it won’t make its next move until you wake it up. To tell
the computer to think again so that it can make its next move, choose Wake Up! from
the Actions menu.

Note: If you’re playing black, and you want to flip the board so that white is on top, choose
Flip Board from the Preference menu or the right-click menu.

Setting the Rules

When you play an unrated game, you can say whether touching is allowed and
whether one or both players play blindfolded.

If Touching is on, and you grab a piece and start moving it, you can change your 
mind and move another piece. However, you must place the first piece back in its
original square before you release it. If Touching is off, you must move the first legal
piece you touch.

If Blindfold Play is on for both players, they can’t see their opponent’s pieces on the
board. This option lets you experience the most difficult form of chess in which you
must remember moves without seeing them on screen. Even advanced players have a
difficult time playing chess blindfolded, so don’t get discouraged if you try it!

Touching and Blindfold Play are considered rules of your game. You can set the rules
of your game using the Setup Game Details dialog.

To turn Touching and Blindfold Play on and off

1. From the Game menu, choose Set Up Game. The Setup Game Details dialog appears.

2. Click the Rules tab, and then check or clear Touching and (Black and/or White)
Blindfold Play.

Playing a Real Game 
In addition to playing unrated (or practice) games, the Kids Room also lets you play
rated (or real) games. When you play a rated game, it’s the real thing — everything
counts! The end result, whether you win or lose, affects your overall rating, so there’s
no taking back moves, no advice, no coaching, and no hints. It’s strictly between you
and your computer opponent.



• Force your computer opponent to move when it’s taking too long, or wake up your
computer opponent when certain actions confuse it or interrupt its thinking.

• Pause a game for a quick break or temporarily quit (or adjourn) a game so you can
continue it later.

• Offer a draw when it seems unlikely that you or your opponent can win, or resign
from a game when it seems unlikely that you yourself will win.

The eight options on the Actions menu are described in more detail in chapter 3, “The
Game Room.” See all the subsections under “Taking Action” on page 29. Note that
when you’re playing a rated game, Takeback Move, Replay Move, Force Move, and
Wake Up! are not available.

Using Quick Hints
If you have no idea about what move to make next, you can ask CHESSMASTER to give
you a suggestion.

To get a quick hint

1. From the Teaching menu, choose Quick Hint. CHESSMASTER displays a suggestion
for the next move to make.

2. Click Move to make the move that CHESSMASTER suggests, or click Cancel if you
don’t want to make the move.

Using the Coach Window
The Kids Room comes with a chess coach that you can use while your playing an
unrated game. (The chess coach is not available during a rated game.) The chess
coach appears as a window with three tabs:

• Advice, which provides a list of all possible moves and the strategy behind them. For
example, it explains when a move pins another piece or relieves a pin; and when a
move forks pieces, checks the opponent’s King, gets out of check, or skewers two
pieces at once. When this tab is displayed, you can double-click any move to make
that move.

• Teaching Modes, which lists the audio and visual tips that you can turn on and off dur-
ing a rated game. For more information on all the teaching modes and how they can
help you, see “Using the Teaching Modes” on page 34 in chapter 3, “The Game Room.”

Like any good coach, the Coach window provides you with a variety of options, and
lets you decide which of those options to use.

To use the chess coach

1. From the Teaching menu, choose Coach. The Coach window appears. A chess
piece next to the option in the Teaching menu indicates the Coach window is open.
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Using the Player Progress Window
Have you ever seen the movie “Searching for Bobby Fischer”? Well, if you have, then
you know all about Master Class points and Master Class certificates. Just like in the
movie, the Kids Room lets you earn Master Class points, which are similar to gold
stars that you often get in school when you do well on a test, or when you help the
teacher clean the white board after class.

If you earn enough Master Class points, the Kids Room rewards you with a Master
Class certificate, complete with your name and the official signature of Josh Waitzkin!

You can earn Master Class points by completing tutorials, drills, and Josh games. You
can also earn them whenever you win a chess game. To see how many Master Class
points you’ve earned, use the Player Progress window. The Player Progress window
lets you track your progress and get rewarded with a certificate when you earn the
required number of Master Class points.

To use the Player Progress window

1. From the Windows menu, choose 
Player Progress. The Player Progress 
window opens. A chess piece next to 
the option in the Windows menu 
indicatesthat it’s open.

2. Look at the number of Master Class 
points that you’ve earned for each 
opponent you beat and for the 
tutorials, drills, and Josh games 
you completed.

3. When you’ve earned the required 
number of Master Class points, 
click the button to print your Master 
Class certificate.

4. From the Windows menu, choose Player Progress again to close the window.

Note: For information on the other windows that you can use to help you during a game, see
“Using the Chessmaster Windows” on page 9 in chapter 2, “Defining Your Room
Environment.” Note that not all the windows are available during a rated game. Remember,
in a real game, there no hints and no advice!

Using the Actions Menu
The Kids Room provides several features that give you more control over your game.
These features are located in the Actions menu, and they allow you to do things like:

• Take back a move when you make a mistake or change your mind, and then make
another move right after.



Displaying Game Details
The Database Room consists of a
menu bar and five tabs — Moves,
Game Info, Key Info, Data Query, and
Position Search. Each tab is divided
into three windows. The top window
changes according to the tab you
select.

The middle window, called the Game
List window, appears the same for all
tabs. It lists all the games in the cur-
rent database. (The CHESSMASTER 7000
game database is the default.) The

bottom window, called the Opening Moves window, also appears the same for all tabs.
It shows a tree of possible moves for the opening selected in the Game List window.

Rearranging the Game List

The columns in the Game List show the game number, the ECO code of the game
opening, the players and their colors, the game results, and the game event. By
default, the games are listed in ascending order by game number.

You can sort games by ECO code, player name, game result, and event by clicking the
appropriate column title. ECO codes appear in alphanumeric order, player names and
events appear alphabetically, and game results appear in ascending numerical order.

You can also rearrange and change the columns that appear in the Game List window.
For example, you can rearrange the order in which the columns appear, delete exist-
ing columns, add new ones.

To rearrange the order in which the columns appear

• Click the column title and drag it in front of or behind another column.

To delete and add existing columns

1. From the Preferences menu, choose Column Setup. The Column Setup dialog appears.

2. To add a column, select the column you want from the Available Columns list, and
then click the -> button. (To add all available columns, click the => button.) 

3. To delete a column, select it in the Selected Columns list, and click the <- button.
(To delete all displayed columns, click the <= button.)

4. To use the default configuration, click Default.

5. Click OK to assign the column settings.
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2. Click the tab you want to use — Advice, Legal Moves, or Teaching Modes. These
two tabs are described above. The Teaching Modes tab is described in chapter 3,
“The Game Room.”

3. To close the Coach window, select it again from the Teaching menu or click the
Close icon (X) on the upper-right corner of the window.

If you open the Coach window during a rated game, CHESSMASTER provides continu-
ous advice on the possible moves. If you’re not sure why a move does what the Coach
says, make the move on the board, examine the position carefully, and then try to
determine what the Coach means. This is a good way to practice different moves and
see their effect.

Note: If you use one of the moves that the Coach suggests, remember that you aren’t stuck
with the move you just made. You can take back a move at any time by choosing Takeback
Move from the Actions menu.

Saving and Opening Games
The Kids Room lets you save the game your playing, whether you finished it or not.
The first step to studying your game is to save as many of your games against as many
different opponents as possible. After you save a game, you can open it at any time
and examine it move by move. This will help you learn what your strengths are, as
well as what you need to improve on as a chess player.

For step-by-step procedures on how to save and open chess games, see “Saving and
Opening Games” on page 36 in chapter 3, “The Game Room.”

THE DATABASE ROOM
Welcome to the CHESSMASTER 7000 Database Room, which contains a huge database
of over 500,000 chess games played throughout history. When you’re in the Database
Room, you can do simple or complex searches for chess games played throughout his-
tory, and even create your own database of games. You can use the database to view
detailed information on each game, including the Move List, game results, events, and
player ratings. You can also analyze game openings, add and delete games, export
games, and search for games by opening line, board position, or multiple search cri-
teria.

Important: Before you use the Database Room, it’s important you review chapter 2,
“Defining Your Room Environment” on page 5. Chapter 2 shows you how to set up a room
to suit your needs and tastes, thereby allowing yourself to get the most out of Chessmaster..
By reviewing it, you’ll learn how to set up sounds and narrated features, as well as specify
the type of chess notation you want to use.



The Key Info tab displays information about the path selected in the Opening Moves
Window at the bottom of the Database Room. This information includes:

• The code of the selected move and the name of the opening.

• Any comments made by the players.

• The number of possible variations of the selected move.

• The number of database games that have gone out of the selected opening path.

• The number of database games that have used the selected opening path.

• The results and player ratings of database games with the same opening moves.

Key information is useful in helping you determine the best openings to use. For
example, if an opening path displays a higher number of winning and drawn games
than losing games, it’s probably a good choice.

To view information about an opening

1. In the Game List window, select a game that uses the opening you want to view.
The opening appears in the Opening Moves window.

2. In Opening Moves window, select the last move that defines the opening path.

3. Click the Key Info tab, choose Key Info from the View menu.

The Key Info tab displays the following information:

•The code, name, and any remark for the selected opening.

•The Subkeys fields show the number of next possible moves and the total pos-
sible moves from the selected position in the opening. For example, if a select-
ed move has 4 possible next moves, and those 4 moves have 4 possible moves,
the total possible moves for the selected position is 8. The Move Tree window
shows the branch of moves from the selected position.

•The Subgames fields show the number of games in the database that have gone
out of the opening book after the selected position, and the number of database
games that have used the moves up to the selected position in the opening book.

To view the games that have gone out of the opening book after the selected
position, click Key Mode in the Move Tree window. The Game List window
updates to reflect the corresponding games. To view a specific game, select it
in the list, and click the Moves tab. To return to the database games, click Key
Mode again.

•The Result fields display the number of games that have won, drawn, and lost
with the same opening.

•The Average ELO fields display the average rating of the players who played
games using the same opening path.
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Using the Opening Moves Window

The Opening Moves window (at the bottom of the Database Room) displays the open-
ing moves for the game selected in the Game List window. The red moves define the
opening, and the black moves indicate the possible paths each opening can take. 

The column titles indicate the move number for each player. For example, “1.” rep-
resents White’s first move, and “1. …” represents Black’s first move. “2.” represents
White’s second move, and “2. …” represents Black’s second move.

Use the arrow buttons on the right to move through the tree of moves for the open-
ing. Click Home button to move the current move in the tree to the home position
(the top cell in the first column). Click Key Mode to view the games that have gone
out of the opening book after the selected position. The Game List window updates
to reflect the corresponding games. To view a specific game, select it in the list, and
click the Moves tab. To return to the database games, click Key Mode again.

Opening the Move List

The Moves tab displays the Move List and a chessboard for the currently selected
game in the Game List window. The Move List uses the current chess notation. You
can use it to view the corresponding moves on the chessboard.

Note: For more information on chess notation, see “Specifying Chess Notation” on page 15
in chapter 2, “Defining Your Room Environment.”

To use the Move List for the current game

1. Click the Moves tab, choose Moves from the View menu.

2. Use the VCR buttons to scroll through each move, or click the moves in the list.
The mini chessboard updates to reflect the current move.

3. Check or clear Show Annotations and Show Variations to hide and display move
annotations and possible move variations respectively. 

Viewing Game Information

The Game Info tab displays the following information for the currently selected game
in the Game List window — the game title, player information, player ratings, elapsed
time, the event name, the site location, the annotator, the round number in which the
game was completed, the date the game was played, and the ECO number (or open-
ing code) in the current chess notation.

To view the game information

• Click the Game Info tab, choose Game Info from the View menu.

Viewing Key Information About Openings



To save the current search query

1. From the Query menu, choose Save Query . The Save Query dialog appears listing
the existing queries.

2. In the Query Name box, type a name for the query, and then click Save (or click
Cancel to cancel the operation).

To open a query

1. From the Query menu, choose Load Query. The Load Query dialog appears.

2. Select the query you want to open, and then click Load. CHESSMASTER opens the
selected query, and the fields on the Data Query tab are populated accordingly.

Note: To delete a query, select the query you want to delete from either the Load Query or Save
Query dialog, and then click Delete. Chessmaster asks you to confirm the delete. Click Yes.

Searching by Board Position

CHESSMASTER also lets you search for games by setting up a specific board position and
using it as your search criteria.

To search for games by board position

1. Click the Position Search tab, choose Position Search from the View menu.

2. Set up the board position by which you want to search using one or more of the
following methods:

• To use all or most of the pieces, click Initial Position to place the white and black
pieces on the chessboard in their starting positions, and then drag the pieces to
the appropriate squares.

• To set up a position that uses few pieces, click Clear Position to start with an
empty board, and then position the pieces by clicking the chess piece buttons
you want to use, followed by their destination squares. Once the pieces are on
the board, you can drag them anywhere you want.

• To use the board position from another CHESSMASTER room, choose Copy Game
From in the Edit menu, and then from the cascading menu, choose the room
from which you want copy the board position.

• To use a board position from a game in the database, use the Moves tab to select
the game you want and to display the desired board position, and then return
to the Position Search tab and click Copy from Moves Tab. For more informa-
tion on the Moves tab, see “Opening the Move List” on page 79.

• To use the selected position in the Opening Moves window, click Copy 
Key Position.

• Check the White to Move check box if it’s White’s turn to move next. Clear it if
it’s Black’s turn to move next. This check box narrows the search results. 
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Searching for Games
CHESSMASTER lets you search for games by setting up a specific board position, or by
performing queries that define game criteria and game parameters. Before you per-
form a search, make sure the CHESSMASTER database is open. If it’s not, use Open
Database in the File menu to open it.

The CHESSMASTER database lets you define queries using a wide range of game para-
meters. For example, you can search by opening moves, players, events, dates, sites,
rounds, ratings, and so on. 

To perform a search

1. Click the Data Query tab, choose Query from the View menu.

2. Using the five drop-down lists, specify up to five game parameters by which you
want to search. You can choose from 22 different parameters, or specify a given
parameter as <empty>. The default five parameters are White Player, Black Player,
Event, Date, and Site.

3. You can type more specific search criteria in the corresponding boxes under each
game parameter. For example, to find a game with a specific Black Player, type the
name of the player under the Black Player parameter.

The more rows you fill, the more specific your search. For example, if you specify
Moves as one of the five game parameters, and you add an opening name to the
Moves column, CHESSMASTER returns all games that use the specified opening.
However, if you add a name to the Moves column and the Black Player column,
CHESSMASTER returns the games that use the specified opening and have the speci-
fied Black player, thus narrowing the results.

The more columns you fill, the more general your search. For example, if you add
only one opening name to the Moves column, CHESSMASTER returns only the games
that use the specified opening. However, if you add two opening names to the
Moves column, CHESSMASTER returns all games that use either one of the openings,
thereby increasing the number of games found.

4. From the Preferences menu, choose Show Deleted Games to include games (in the
search) that are marked for deletion.

5. Click Search, choose Load Query from the Query menu to perform the search. The
games that match the criteria appear in the Game List window.

6. Click Stop, choose Cancel Query from the Query menu to cancel the search.

7. Click Clear, or choose New Query from the Query menu, to clear the rows and
columns and display the default game parameters, so you can define a new search.

Saving, Loading, and Deleting Queries

CHESSMASTER lets you save the search queries that you define, so you can use them
again. For complex queries, this can save you a lot of time.



4. In the Open As box, make sure Auto or Database is displayed.

5. Select the database you want, and then click Load. CHESSMASTER displays the cor-
responding games in the Game List window.

Importing and Exporting Games

You can import saved games — in Portable Game Notation (.PGN) format — to any
CHESSMASTER database. This provides a convenient way to organize and categorize
your games.

To import a game to a database

1. Open the database to which you want to import the game using the procedure out-
lined above.

2. From the File menu, choose Import Games. The File Open dialog appears.

3. Use the Look In box to specify the folder that contains the game you want to import.

4. In the File of Type box, select Portable Game Notation (.PGN). 

5. In the Open As box, accept Auto, and then click Load. CHESSMASTER adds the select-
ed game to the Game List window.

You can export games from any CHESSMASTER database to Portable Game Notation
(.PGN) format. You can export more than one game at a time.

To export a game

1. Make sure the database that contains the game you want to export is open. (Use
the procedure outlined in the previous section.)

2. From the Game List window, select the game(s) you want to export. Use Ctrl or
Shift to select multiple games.

3. From the File menu, choose Export Selected Games. The Export Game dialog
appears.

4. Use the Save In box to specify where you want to export the game.

5. In the Save as Type box, accept PGN Game Files. 

6. Use the default file name or type a new one in the File Name box, and then click
Export. CHESSMASTER exports the file to the specified folder, file type, and file name.

7. If you’re exporting multiple files, CHESSMASTER re-displays the Export Game dialog
for each file. Repeat steps 4 through 6.

Omitting Games During a Search

CHESSMASTER lets you mark games for deletion so that it doesn’t look for them during
a search. When you mark a game for deletion, a D appears next to the corresponding
game name in the Game List window. If you mark a game for deletion, you can always
unmark it so that the database sees it again.
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• To remove pieces from the board, drag them off the board or click Clear Position
to clear the board of all pieces.

3. Click Search to search the current database for games with the specified position.
CHESSMASTER displays the games it finds in the Game List window. (Click Stop at
any time to cancel a search.)

Working with Databases
In addition to viewing and searching for games in the CHESSMASTER database, the
Database Room also lets you:

• Create and open new databases.

• Import and export games to and from databases.

• Mark games for deletion so that CHESSMASTER ignores them during a search. This
does not delete game permanently from a database.

• Optimize, delete, and close databases.

Creating and Opening Databases

To organize some of your own games, you can create a new database to store them.
When you create a new database, you start from scratch, and then import the games
you want to include.

To create a new database

1. From the File menu, choose New Database. The Create File dialog appears listing
the database files from Program Files\Chessmaster 7000\Database Files. 

2. In the Save In box, keep Database Files as the location for the new database.

3. In the Save as Type box, accept the default Database File (*.TBG) as the file type. (You
can save Portable Game Notation (.PGN) files to the CHESSMASTER database as well.)

4. In the File Name box, type a name for the database.

5. Click Save to create the new database. A message appears indicating that a new
database is being created, and then the Database Room displays an empty Game
List window.

6. Add the games you want to your new database. For information, see “Importing
and Exporting Games” on page 84. 

To open an existing database

1. From the File menu, choose Open Database. The File Open dialog appears listing
the database files from Program Files\Chessmaster 7000\Database Files. 

2. Use the Look In box to specify the folder that contains the database you want to open.

3. In the File of Type box, make sure Database File (*.TBG) is displayed.



To copy a game from another room

1. From the Edit menu, choose Copy Game From, and then from the cascading menu,
choose the room from which you want to copy a game. CHESSMASTER asks you if
you want to save the current game.

2. Click Yes to save the current game, or click No to copy the game from the 
specified room on to the current chessboard. If you click Yes, the File Save 
dialog appears.

3. From the Save In drop-down list, specify the folder where you want to save your game.

4. From the Save As drop-down list, choose a file type for your game. Select Portable
Game Notation (.pgn) if you want to export the game to another chess application.

5. In the File Name box, type a name for the game you’re saving. You can use the
default (based on the players and the date) or type your own.

6. Click Save. CHESSMASTER saves the current game to the specified folder, file type, and
name, and then copies the game from the specified room onto the current chessboard.

Copying the Move List and Chessboard
The Copy option on the Edit menu uses a cascading menu of additional options that
let you copy the Move List and the chessboard (in different formats) to the Windows“
clipboard. After you copy them to the Windows“ clipboard, you can insert them into
another application (such as Microsoft“ Word) using the application’s Paste command.

For more detailed information, see the corresponding section in chapter 3, “The
Game Room.”

ABOUT THE ENGINE
The King
In 1987, Johan de Koning (de Koning is Dutch for “The King”) started writing chess
programs. The first version of “The King” was running on a 68000 processor, which
had been introduced in microcomputers shortly before. Always trying to improve per-
formance, The King was rewritten for the ARM-family of RISC-processors and finally
for the Intel 80X86-family. From the start, The King was given an attractive and enter-
prising playing style. Unlike many other computer programs, The King actively seeks
attacking possibilities and is ready to sacrifice material not only on tactical, but also
on positional grounds. Results and playing strength of the program steadily increased,
and it has been among the world’s strongest ever since 1990.

Tasc 
The development of The King was accompanied by an ever-increasing variation of
environments that the program is running in-often provided by the Dutch company,
Tasc, which specializes entirely on the subject of “chess and computers.” Tasc pub-
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To mark a game for deletion

1. Open the database that contains the game you want to mark for deletion.

2. From the Game List window, select the game(s) you want to mark. Use Ctrl or Shift
to select multiple games.

3. From the Edit menu, choose Delete Selected Games. CHESSMASTER displays a D next
to the selected games, indicating that these games should be ignored during all sub-
sequent searches.

Note: To unmark a game for deletion so that Chessmaster sees it again, select the game(s)
you want to unmark, and then choose Undelete Selected Games from the Edit menu.

Optimizing, Deleting, and Closing Databases

CHESSMASTER lets you optimize the database by permanently deleting games you have
marked for deletion and indexing new games that you have added. This considerably
improves the search and indexing performance of the database.

If you make extensive changes to an existing database, or create a new one, it’s a good
idea to run the optimization feature.

To optimize a database

1. Open the database you want to optimize.

2. From the File menu, choose Optimize Database. The Optimize Database dialog
appears.

3. Make sure a check mark appears next to Clean Database and Create Index Files 
to permanently delete games that are marked for deletion and to index the 
games you added.

4. Click OK to optimize the database and enhance its performance.

To delete a database

1. Open the database you want to delete.

2. From the File menu, choose Delete Database. CHESSMASTER asks you to confirm 
the delete.

3. Click OK.

To close the current database

• From the File menu, choose Close Database. CHESSMASTER clears the Game List 
and Opening Moves windows. Use Open Database in the File menu to open 
another database.

Copying Games from Other Rooms
CHESSMASTER 7000 introduces a new feature that lets you copy a game from any other
room into the Game Room.



a form that we can now recognize as chess, is a different kettle of fish. Who could have
then guessed it would not only survive but flourish over centuries? Why should details
of its earliest period have been considered important enough to record or preserve?

Since clear historical reports of the origin of chess are not present, we can determine
the time and place of chess’s invention only indirectly and approximately. The task is a
bit like that of the archeologist who must reconstruct the history of a plant or animal
on an incomplete fossil record — we must fill in the gaps with reasonable guesses con-
sistent with the clear, but spotty, evidence that does exist.

Indian Origins

Of all the time periods advocated, the best evidence is that chess originated in India
about the middle of the sixth century a.d. Such a date is suggested by a Persian poem
written about 600 that refers to chess coming from India. Literature dated about 50 to
150 years later again describes chess as coming from India to Persia. So the early
sources corroborate each other on this important issue.

Further, no specific reference to
chess appears before the  period
around 550, even though there is
vast literature from India as well
as detailed literature from for-
eigners visiting India. This clear-
ly suggests that chess had not yet
been invented, else it would be
mentioned in the literature that
survives from this era.

It is precisely because the actual
invention of chess can be determined only with indirect methods that so many different
theories concerning its origin have been offered, each with its own indirect proof. In addi-
tion to this lack of direct evidence, the immense strides made in historical scholarship in
recent years show many earlier methods or sources to be clearly unreliable, and at the
same time historians have uncovered many new sources. Earlier writers tended to treat
even obvious fictional accounts as evidence of a true history of chess—even King Arthur
was suggested as a possible inventor! It’s easy to see why theories of the origin of the
game were muddled for so long.

Early Chess

The original name for the game was chaturanga (literally “four-limbed”), from the
Sanskrit words chatur meaning “four” and anga meaning “parts.” The name refers to
four army divisions—foot soldiers, cavalry, chariots, and elephants. This earliest chess
was played on the ashtapada (literally “eight-footed”), a board of sixty-four squares.

The “four-part” aspect of the Sanskrit word for chess has sometimes been misunder-
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lishes interactive chess tutorials, a database program, and chess data on CD-ROM. 

Tasc maintains a Web site with product information, demo-software, and regular
(live) coverage of chess news and tournaments at: http://www.tasc.nl.

THE HISTORY OF CHESS

An Essay by M. L. Rantala

Chess players who accept the general and long-standing prohibition on discussing 
religion or politics might do well to add the history of chess to the forbidden realm.
Heated disagreement continues to this day as to its origin. Writers and theorists have 
variously attributed the invention of chess to nearly all the great ancient civilizations
of Africa, Asia, and Europe, and some even claim that the event occurred as early as the
emergence of humanity.

In some theories, specific individu-
als are bestowed with the honor of
invention; the list of experienced
inventors includes (along with one
of their actual “inventions”):
Adam (sin), Hermes (the lyre),
Palamedes (the convention of eat-
ing three meals a day), Queen
Semiramis (the founding of
Babylon), King Solomon (humane
justice), and Aristotle (doctrine of
the golden mean). Not only did
none of these figures invent chess,
not one of them ever played it.

Games with superficial similarities
to chess have existed for thousands
of years and have been depicted, for

example, on ancient Egyptian tombs. But these similarities are almost certainly due to
chance. No clear link to chess has yet been established, and it is unlikely such a link could
be proven.

The Mysteries of History

Many dates are easy to establish by the historical record. For example, the coronation
of a new monarch will be preceded by evidence of the previous ruler’s death, reports of
the preparations for the coronation ceremony, contemporary accounts of the installation
of the new ruler, and so on. In such cases, the historical record is often rich and detailed.
But the matter of a new game, which at the time it was “invented” or at least fixed in



The Persians

From India, chess moved to Persia (now Iran). It seems likely that chess was introduced
during the reign of the Persian monarch Khusrau Nushirwan, who ruled from 531 to
579. We know from literature of this era that by the year 600 chess was already an
established pursuit of the Persian nobility.

In its early years in Persia, chess com-
peted for popularity and acceptance
with other games, notably backgam-
mon. Fanciful writing comparing the
two games was common. Written works
mentioning chess often included specu-
lative explanations for the 
invention of chess—it was claimed to be
a method to educate princes, or it served
as a surrogate for kings with no actual
enemies to vanquish.

A Pawn among the Pawns

Chess moved to the Islamic world from Persia and probably spread during the period
from about 650 to 750. It is in the Arab world during the mid-ninth century that the
oldest recorded words on chess theory exist. By the year 988 the writer Ibn an-Nadim
mentions several players who had already written books on chess. During this early
Islamic period, many writers not only contributed to the understanding of chess theo-
ry, but went to great pains to produce moral justifications of chess. Since the game was
not mentioned in the Qur’an, its religious status was uncertain. Supporters of chess
praised it in the hope that it would not be lumped in a category of banned activities,
such as gambling. Chess pieces during this era were generally nonrepresentational
because Muslim practice banned images.

Islamic poets wrote of chess and used chess ideas as metaphors. Al-Farazdaq wrote a
poem that included reference to the lowly level of the pawn: “I keep you from your
inheritance and from the royal crown so that, hindered by my arm, you remain a pawn
among the pawns.”

Further Travels

From India, chess also traveled to China, Japan, and other Asian countries. Chess is
first mentioned in Chinese literature written in about the year 800. In their modern
forms, Chinese and Japanese chess are significantly different from what the rest of the
world today calls chess. Yet there are important common features—for example,
Chinese chess includes a horse that moves exactly like the knight in Indian chess. This
makes it unlikely that they represent completely different games that evolved indepen-
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stood to imply that in its original form it was a game for four players. There is evidence
of a four-player version of the game, but this seems to have been an offshoot of the orig-
inal version and not particularly popular. Four-handed chess does not seem to have
thrived outside of India. 

It is important to note that chaturanga was a word first applied
directly to Indian armies, only later to chess. Similarly, the ash-
tapada existed as early as the second century b.c. This means
that in its original form, chess was seen explicitly as a war

game, since it was named directly after the army, and was
played on a gaming board that had already been used for
many different games over the centuries. It is this latter fact

that has caused many theorists to urge upon us the belief that
chess is hundreds of years older than the historical record actu-
ally shows.

What specific role the ashtapada played in developing chess is
unknown. One possibility is that it was used for games com-
pletely unlike chess and that its use for chess was a true inno-
vation. Another theory is that the ashtapada has always been
associated with something like chess but that we know nothing

whatever about this precursor game. Still others suggest that
the ashtapada was first employed for astrological pur

poses and only gradually became employed as a game
board.

The earliest reference to chess in the surviving
Sanskrit literature occurs in about 625. The poet Bana
praises the Indian ruler Harsha, who reigned from
606 to 647. Bana describes this king of Kanauj as a

prince of peace, noting that in his reign the only wars in the country were among the bees
hunting for pollen, the only feet cut off were those in the meter of poetry, and the only
armies were those that moved on the sixty-four squares.

Impenetrable Darkness

The history of chess before these first Sanskrit and Persian references is unknown to
us—and may forever remain unknown, even though interest and controversy abound.
After examining the complete lack of any reliable documentation older than the seventh
century, one chess historian referred to the period before this in the history of chess as
“impenetrable darkness.” Perhaps forever unanswered will be even the fundamental
question of whether the game of chess was created by a single mind or was the accu-
mulation of contributions of many minds from several times and places.



the introduction of chess and even today we know little about how these games van-
quished by chess were played. Chess’s victory over these other games was so complete that
references to them might be rendered as “chess” when translated to another language.

Chess was first played in Europe by clerics. There is much early literature mentioning
Christian bans on chess, but clearly these were ineffective. By the fourteenth century,
one Christian writer only condemned a person for the sin of pride in wanting to play
well at chess—he did not condemn the game itself.

From the church, chess moved to the nobility. By the twelfth century, a description of
knightly accomplishments lists chess along with riding, hawking, and verse writing.
Chess was often played for money or other stakes, as was common with many games
of the era. The most common form of a win during medieval play was the “bare king,”
where the winner captured all of his opponent’s pieces, leaving the king standing alone.
This is suggested by surviving records of chess bets, which indicate that the relatively
rare checkmate was commonly worth double stakes.

Chess, like many games and pastimes, was regularly mentioned in literature of this peri-
od, with lovers meeting over a game of chess, for example, as a common story element.
But medieval literary chess writing is most notable for its use of allegory. A story about
a chess game could actually be a story of love or war or treachery, and so on. Such alle-
gories often analogized the different strengths of the pieces to the social hierarchy of the
day. A game of chess might be used as a literary device to represent two feudal lords and
their vassals in combat or, more generally, to express the duty of people of different social
ranks. One of the most famous of these moral allegories was written by Jacobus Cessolis.
William Caxton translated it into English as The Game and Playe of the Chesse, and in
1475 it became the second book to be printed in the English language.

The Chess Renaissance

In the first five hundred years in
Europe, chess changed very little. It
was primarily a social pastime
rather than an intellectual pursuit.
In consequence, there were few the-
oretical or technical advances
beyond those recorded in the
Muslim literature that traveled to
Europe following the introduction
of chess. The small changes that
took place in the first few hundred
years were primarily superficial, such as the evolution from abstract to representation-
al design of the pieces.

There were certain signs that presaged major changes to come later: in sporadically
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dently. Interestingly, in parts of Asia such as Burma, both Indian and Chinese chess
were adopted as popular games.

One interesting theory of the origins of chess suggests that it actually was created in
China and was the natural evolution of an astrological ritual. But this theory is but-
tressed more by speculation than evidence. 

Western Europe

Chess made its way to western Europe via the Arab world before the close of the first
millennium. Subsequently, Europe became the most fertile source of chess development
in the second millennium.

Whether chess came first to Spain or to Italy is unknown. It is even possible that it
arrived in both countries at about the same time.

The earliest established written account in Europe that includes a mention of chess
occurs just before the year 1000. Whether chess was still quite new then or had been a
part of western European culture for a century or more is not known. By the time chess
is regularly mentioned in European literature, its origins were often fancifully
described; one story that is often repeated in medieval literature is that chess was
devised during the siege of Troy in order to assuage boredom.

It was in Europe that the
pieces moved from abstract
designs to representational
forms. Among the most impor-
tant pieces of evidence estab-
lishing the existence of
medieval chess and the repre-
sentational form the pieces
took are the chess pieces
known as the Lewis

Chessmen. Found in 1831 on the Scottish Isle of Lewis, these 
seventy-eight pieces — parts of four different and incomplete sets—date from the
twelfth century. They are carved from walrus ivory and likely originated in
Scandinavia. All are now housed either in the British Museum or the National Museum
of Antiquitiesin Scotland.

From Indus to Iceland

After chess reached Europe, it spread rapidly. By the beginning of the thirteenth centu-
ry, it had conquered this continent, one chess historian describing its penetration as
“from the Indus to the Atlantic and from the Sahara to Iceland.”

So popular was chess in medieval Europe that it completely displaced previous games.
The Irish fidchell and the Welsh gwyddbwyll were games of skill that did not survive after



First in 1574 and then in 1575 the priest played matches with Leonardo di Bona and
Paolo Boi in Madrid. These were significant not only because López’s losses on both
occasions marked the beginning of his diminished influence on chess, but also because
they represented the first documented examples of an organized and patronized chess
match. Philip II funded both matches of the Spaniard López against the two leading for-
eign players, with Leonardo and Boi earning rich prizes from the Spanish king.

An accurate biography of these two men is difficult to piece together. They were the sub-
ject of much contemporaneous writing, but which reports are true and which false is
now hard to determine. Each was said to have been captured by pirates and to have
extricated himself by winning at chess against the pirate leader. Both were said to have
eventually succumbed to death by way of poison.

From Darkness to Light

The period following the publication of Ruy López’s book
was rich for the development of chess and includes the

publication of some important chess contributions.
Royal and noble patronage sustained talented

players and promoted advances in theory. As
the Spanish priest cast scorn on his predeces-
sor Damiano, one of López’s German critics
claimed that the progression from López to
the Italian theorist Polerio is "to step from
darkness into light," marking how rapidly
chess was improving during the
Renaissance.

Another great contributor of the era was the
Italian player Gioacchino Greco, Born in

1600, he traveled throughout Europe support-
ing himself by winning at chess and selling his

hand-copied manuscript. Some twenty or so copies
of his manuscript survive, showing how far the

Italian theory of chess had advanced compared
with the rest of Europe. Greco wrote for an
advanced player, using extensive opening
analysis and game examples but little in the
way of explanatory prose. His greatest influ-

ence on European chess came after his death, at
the age of thirty-four, when his work was published in printed form in various languages,
including English, French, and German. Some fifty years after his death, the French his-
torian Pierre Bayle wrote in his Dictionaire Historique et Critique that Greco “was so
excellent a player at chess, that it cannot be thought strange that I should give a short
article of him. He never had any equal to him at this game in any part of the world.”
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locations, rules sometimes permitted a pawn to advance two squares on the first move,
and there were early attempts to modify the queen’s move. But these are more accurate-
ly considered experiments rather than clearly codified changes.

But late in the fifteenth century there was a sudden reform in the rules that was quickly
adopted throughout Europe. These changes represent the single major shift in the game in
its entire recorded history. One of the new rules permitted a pawn to advance two squares
on its first move. This had the effect of speeding up the game without materially affecting
the general tactics of play. The other changes were fundamental: The bishop was permit-
ted to move further, giving it approximately the same strength as a knight; and the queen
moved from a very weak piece (weaker than the king, in fact) to the strongest piece on
the board. This was effected by making the queen’s move a combination of the rook’s and
the (new) bishop’s moves. This latter change was so significant that literature of the peri-
od referred to the reformed game descriptively as “the queen’s chess” or, in an uncompli-
mentary judgment, as “mad chess”!

The First Best-Seller

A description of this new chess appears in a Spanish book by the chess theorist Luis de
Lucena. Titled Art of Chess, it was printed—interestingly—in a binding along with his book
Discourse on Love and published about 1496. (As one chess scholar has observed, “Love and
chess may not seem like related topics, but to Lucena they were both miniature warfare.”)
Lucena’s book contains eleven examples of openings and one hundred and fifty problems
almost evenly divided between the old chess and the queen’s chess. Examples of this work
survive today.

The second surviving book on chess theo-
ry of this period was published in 1512 by
the Italian Damiano, who does not even
mention medieval chess, suggesting that
the new form had completely conquered
Italy by this time. Lucena’s book was elab-
orate and lavish and was never reprinted.
Damiano’s, printed both in Italian and
Spanish, went through eight editions in
the course of half a century, causing one
historian to remark that it was “the first
best-seller of the modern game.”

A Spanish priest who read Damiano’s book found it thoroughly inadequate, so he pro-
ceeded to compose his own. Ruy López de Segura was considered one of the leading
players of his day and his book, published in 1561, was an advance on previous schol-
arship. He concentrated on the openings rather than on problems and introduced the
term gambit to chess literature. He is also remembered for advising chess players to
place the board in such a way that the sun will be in the opponent’s eyes!



The Café de la Régence was established in 1670 by an American. It drew the leading
players of the day, including Légall de Kermeur, François-André Danican Philidor,
Alexandre Deschapelles, Bourdonnais, and Saint-Amant as well as famous amateurs
like Voltaire, Rousseau, Robespierre, Napoleon, and Benjamin Franklin.

Benjamin Franklin’s famous 1779 essay on chess, “The Morals of Chess,” certainly
speaks to the esteem in which he held the game. But many of the qualities he attributed
to it could just as well result from other forms of mental training—Franklin didn’t actu-
ally isolate anything that was unique to chess. His essay is also the source of chess eti-
quette, including some amusing advice:

You must not, when you have gained a victory, use any triumphing or insulting expres-
sion, nor show too much pleasure; but endeavor to console your adversary, and make
him less dissatisfied with himself by every kind and civil expression, that may be used
with truth; such as, You understand the game better than I, but
you are a little inattentive; or, You play too fast; or, You had
the best of the game but something happened to divert your
thoughts.

Although he was American, Franklin’s contribution to
chess should be noted in a French context. His essay was
written while he lived in France and it was published in
London before it was ever published in the United States.
Further, Franklin had difficulty in locating opponents in
America and, subsequently, played most of his chess during his
Paris years.

The Legacy of Philidor

Without a doubt, the brightest star to emerge from the Café
de la Régence was Philidor. Remembered in chess circles
for his playing feats and influential book on the game,
this Frenchman, whose father had served as keeper of
the king’s music library, was also a leading compos-
er of operas. One of his most amusing early chess
exploits took place during a lull in activity for the
king’s musicians. The young Philidor, who was a member
of the choir at the Chapel Royal at Versailles, played chess with one of the older musi-
cians, whose temper grew sour as his position weakened. After Philidor delivered mate,
he ran from the room, worried over his opponent’s reaction to defeat!

When his voice broke, he left the choir and spent considerable time at the Café de la
Régence, where he met Légall de Kermeur, who became his teacher. Philidor soon out-
performed Légall, who up to that point had been the leading player of the day. In his
early twenties, Philidor traveled to London where he won a match against Philip
Stamma, played at the center of London’s chess vortex, Slaughter’s. He was only twen-
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During Greco’s lifetime, commercially published literature in much of Europe was far
below his advanced standards. For example, Famous Game of Chesse-play published in
England in 1614 provided much more detail on appropriate over-the-board conduct
than actual analysis. The success of this book is one piece of evidence demonstrating
the growing popularity of chess as a mere pastime befitting a person of rank.

Chess in the Renaissance continued to provide a backdrop for commentary unrelated to
the game itself. An anti-Spanish play, A Game at Chess, played to sold-out houses in
London for nine consecutive days in 1624 and was discontinued only because of the
protests of the ambassador from Spain.

The Maturing Chess Culture

As we have already seen, much of the progress in chess occurs in fits and starts. In the
era roughly overlapping the end of the Renaissance and the beginning 
of the Enlightenment, chess stagnated in some parts of Europe, although it never fell
completely out of favor. Theoretical advances and even increases in popularity occurred
piecemeal throughout the continent.

During the seventeenth century the
milieu of chess began to mature, and
much of what we associate with
modern chess culture started to
emerge: a detailed literature, profes-
sional players, team matches, inter-
national competitions, a coterie of
devoted amateurs, and spectator
specialties such as blindfold exhibi-
tions. In this period chess was seen
less as simply the appropriate avo-
cation of the leisure class and more

as an enterprise with both challenging sporting and intellectual elements. Its symbolic
significance was seen as less important that the intrinsic quality of the game itself.

Coffeehouse Chess

Coffeehouses first appeared in Europe during the seventeenth century. Sites designed for
the casual or more studied pursuits of leisure activities, were particularly popular in
London and Paris.

By the eighteenth century the pursuit of chess had become rather bookish, and it grew
in favor among intellectuals. Leibniz, the great mathematician, considered it to be good
mental training. The centers of chess activity during this century were England and
France. In Paris, the Café de la Régence was the leading chess-playing venue.
Established in the late seventeenth century, the leading London chess cafe was
Slaughter’s Coffee House. 
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ty-two years old when he wrote his famous and successful book on chess, L’analyze de
échecs (1749). Philidor argued that the greatest flaw in players of the day was their
incorrect pawn play. “Pawns are the soul of chess” is the most common English render-
ing of the most famous line from his book. He also introduced the concepts of blockade,
positional sacrifice, and prophylaxis.

For all his skill in multiple fields, Philidor was described by his contemporaries as a
dull man. One of his admirers, in explaining his lack of wit, is said to have explained,
“That man has no common sense—it is all genius.”

It was not surprising that Philidor had been drawn to London. Chess players at
Slaughter’s were serious students of the game. One chess book published during this
period contained the advertising line “sold only at Slaughter’s-Coffee-House, in St.
Martin’s Lane.” And a Slaughter’s regular, Philip Stamma, had published the most influ-
ential chess book of the decade preceding Philidor’s own work. Stamma took great pains
to attack the work of Greco, for example deriding Greco’s concentration on the King’s
Gambit by writing, “I regard this method as utterly useless and without foundation.”
But after his loss in his match against Philidor, he published nothing further.

While Philidor dominated eighteenth-century chess, there were theorists of note outside
his influence. In Italy, three writers achieved prominence: Ercole del Rio, Giambattista
Lolli, and Domenico Ponziani. Del Rio’s writing contained problems of high quality. Lolli
wrote the best work on endgames of his era. Ponziani’s book provided a wide view of
strategy and analyzed a large number of openings. Together these writers were known
as the Modenese school and were also critical of Philidor. They represented the end of an
era in Italian chess. Following the publication of their works in the mid-1700s, no con-
tributions of any note would be produced in Italy in the following hundred years.

Human versus Machine

One odd “innovation” of the eighteenth century was the so-called mechanical chess play-
er. Several were devised, but they all followed a basic scheme: A box of some sort pur-
ported to show machinery on the inside. The machine appeared to play chess with a
mechanical arm. In fact, all such devices played chess entirely by human intervention.
The first automatons had humans concealed inside the box, while later ones were operat-
ed from a distance via electricity.

The first mechanical chess player was a machine created in 1769 by Baron Wolfgang
von Kempelen, a Hungarian civil servant. It consisted of a life-sized figure dressed in
Turkish robes attached to a cabinet. Kempelen described it as a chess-playing automa-
ton, but it was, in fact, operated by many strong players. Nonetheless, precisely how it
worked was the subject of great speculation. It achieved sufficient enough interest that
Philidor played it and beat it easily.

A hundred years later similar automatons
surfaced. Ajeeb was a machine that, in
1868, English cabinetmaker Charles Arthur
Hopper claimed was a chess-playing
machine. It was exhibited first at the Royal
Polytechnical Institute and later at the
Crystal Palace. It was shaped like a figure
of an Egyptian and operated by a person
concealed inside. In New York, its opponents
included Sarah Bernhardt and O. Henry.
One of its concealed operators in the United
States was Harry Pillsbury, and after
Pillsbury’s death, the automaton was used
only to play draughts (checkers).

Charles Godfrey Gumpel constructed
Mephisto and first demonstrated it in

London in 1878. Mephisto, like the Turk and Ajeeb before it, was described as a chess-
playing automaton. But like these others, it was merely a device that contained a per-
son who played chess. Operated by Isidor Gunsberg, it was the first automaton to actu-
ally win a chess tournament.

The Nineteenth Century

The economic prosperity of the nineteenth century led to a larger number of educated
people who found chess both challenging and congenial. It was in this era that clubs
devoted exclusively to chess began to proliferate, particularly in Great Britain.

Technological advances aided the expansion of chess playing: movable type reduced
printing costs resulting in inexpensive editions of numerous books on chess as well as
the first chess magazines. Because of the complexities of chess, written material for
players of all skills helped to promote the game.One of the most important events in the
first half of the century was the pairing of Louis Charles Labourdonnais (an alumnus
of the Café de la Régence) and Alexander MacDonnell (a Scot who had established
prominence in British play) in several London matches in 1834. Although
Labourdonnais was the clear winner of the match, MacDonnell won some interesting
games. This contest between two established players created immense interest in chess.
Games of the match were published in many sources and were studied by both students
and teachers of chess.

The year following the Labourdonnais-MacDonnell match, the first popular chess col-
umn appeared in Bell’s Life  in London. Demand for chess literature was so strong that
two chess publishers engaged in a price-cutting war that benefited neither of them but
made available to the public very inexpensive editions of many popular chess books.



International Tournaments 

But the most important international development in this period was the international
tournament. The first was held in London in 1851, organized by Staunton, who devised
the rules of the competition. Many of the top European players traveled to London to
participate, guaranteed their expenses if they did not earn a prize. It was a knockout
tournament without seeding so some popular players were eliminated from the tourna-
ment before it ended, including Staunton himself, who was knocked out in the semifi-
nal round by Adolph Anderssen, who later won the tournament.

In the second London tourna-
ment, held the following year,
an all-play-all format was
employed, and only a few years
later the convention of scoring
a draw as half a point was
instituted.

The rise of tournament play
brought the issue of timing
games to the forefront. Left
unrestricted, players might per-
mit games to extend for hours
on end. Henry Buckle, a British
historian and an accomplished
chess player, commented on the

pain of playing chess against a sluggish opponent: “the slowness of genius is hard to
bear, but the slowness of mediocrity is intolerable.” Staunton ruled at the first London
tournament that players had a limit of two hours to make each twenty-four moves.
Hourglasses were used. Some twenty years later a special clock was devised for timing
chess play. Today, no serious tournament proceeds without clocks used for every game.

The Morphy Sensation 

While the nineteenth century is known for some of the great parings in chess history, it
is also famous for one of the great matches that never took place. The American Paul
Morphy became a chess sensation at an early age. In 1858, at the age of 21, he trav-
eled to Europe to play chess, particularly expecting to play a match against Staunton.
(Staunton had refused to come to the United States to play Morphy.) He easily won
matches in London and Paris, playing brilliant, sparkling chess. But he never had a
chance to face Staunton across the board. The Englishman, who would almost certain-
ly have been beaten by this challenger, repeatedly put off the match and eventually
refused to play it, thus denying Morphy the chance at the unofficial title of world 
champion. He returned to America, soon gave up chess, and later in life suffered 
from mental illness.
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Not all chess centers experienced the same success as London during the early part of
the nineteenth century. Labourdonnais founded and edited the first chess magazine the
year after his great victories over MacDonnell. But Le Palamède (named after
Palamedes, one of the noninventors of chess!) lasted only a few years. The magazine
died with Labourdonnais in 1840, to be resurrected only briefly by another leading
French player.

At about this time the first modern, encyclopedic treatment of the openings came out of
a Berlin group of chess enthusiasts known as the Pleiades. Paul von Bilguer began writ-
ing the Handbuch des Schachspiels, and the first edition was finished by Baron Tassilo
von der Lasa after Bilguer’s death.

Staunton’s Contribution

The preeminence of London as the world’s leading nineteenth-century chess center was
unquestionably established with the emergence of Howard Staunton on the chess scene.
He founded the Chess Player’s Chronicle, and little feuds between English and French
players were sometimes played out in this journal and Le Palamède. Staunton was a
man of sour disposition, described by one chess historian as “liable at almost any time
to start an argument with almost anybody.” Nonetheless, at his height he was the
supreme player of the world. What still today is the most popular design for chess
pieces is named Staunton—not because he designed them, but because their creator,
Nathaniel Cook, wanted to use Staunton’s prestigious name to promote them.

During the era of Staunton, the first national organization to promote chess was estab-
lished. It grew out of the Yorkshire Chess Association.  At the same time that local clubs
flourished, chess at its highest levels became more and more international. By the end
of the nineteenth  century, international matches were conducted via telegraph.



ed—among other things—control of the center from a distance. They promulgated their
ideas not only in writing but in wins across the board.

The twentieth century saw the rise to prominence of national chess organizations,
which generally hold national title tournaments once a year. Yet the world champi-
onship remained different. For the first half of the century it was held at irregular inter-
vals; it was based on match, not tournament, play; and it remained controlled by the
champion himself. Lasker was replaced by Capablanca in 1921, who lost to Alekhine
in 1927. Alekhine, showing up for some games drunk, lost his title in 1935 to Max
Euwe in a very close match. He regained the world championship in 1937 and held it
until his death in 1946.

Soviet Chess 

Chess was treated very seriously in the Soviet Union from the very beginning of
Communist rule and no country has had a greater influence on chess in our century.
Given support by the government, chess was encouraged throughout the Soviet state.
(There are certain ironies in the Soviet enthusiasm for chess: most of the support for
chess in pre-Communist years owed much to the aristocracy; chess as a war- training
tool is a “bourgeois” notion, and so on.) But money and support were poured into chess,
and as a game it flourished. Hard to prove is whether such support alone 
created the vastly successful Soviet chess players of the twentieth century or if such suc-
cess is due in large measure to the fact that Soviet organization meant that 
chess was one of the few areas in which a talented individual could earn prestige and
financial reward.

Only after Alekhine’s death in 1946 was FIDE able to
take control over the world championship. In order to
ensure that its players had a chance to participate, the
Soviet Union finally joined FIDE in 1947. FIDE ran the
world championship tournament of 1948 that installed
the Soviet Mikhail Botvinnik as world champion. A pow-

erful player, he reigned until 1963, with only two small
breaks (Smyslov was world champion from 1957–58 and
Tal reigned from 1960–61).

Formal chess titles, such as grandmaster, were officially
established by FIDE in 1950, and FIDE’s olympiads con-
tinued to grow in popularity.

Fischer Fever

The 1960s saw the rise of an American phenome-
non. Brilliant and mercurial, Bobby Fischer cap-
tured attention wherever he played. Fischer got close
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First World Champion

The increasing professionalization of chess also brought new titles for players. While
many players and their fans may have fancied themselves world champion, the first
player widely recognized as such was Wilhelm Steinitz. (Having beaten Anderssen in
1858, Morphy is often considered one of the “unofficial” world champions.) Steinitz
essentially created the title himself in 1866 and defended it several times, finally losing
the crown to Emanuel Lasker in 1894. Steinitz was 58 years old when he finally relin-
quished the chess crown and lived only six more years. With Steinitz holding the title
for twenty-eight years and Lasker holding it for twenty-seven, no world champion to
follow them would ever reign for so long.

The title of grandmaster became popular in the late nineteenth century after the
Russian Czar used it to describe the top five players who were invited to play in a tour-
nament in St. Petersburg in 1895–96.

The Twentieth Century 

Chess blossomed in our own centu-
ry, with both popularity and techni-
cal contributions growing rapidly.
Like so many other endeavors,
chess was temporarily stopped in
its tracks during the First World
War. The very international nature
of chess disadvantaged some play-
ers when war broke out—Russian
players participating in the
Mannheim tournament of 1914
were interned in Germany when

war was declared! And the chess scene was different after the war ended. Some of the
most lavish features of the previous years, such as truly huge professional events last-
ing weeks and weeks, never reappeared.

The most important administrative development of the twentieth century was the cre-
ation of a world chess body. In the summer of 1924, delegates from fifteen countries met
in Paris and established the Féderation Internationale des Éches. This world organiza-
tion is generally referred to by its acronym: FIDE (pronounced FEE-day). Its wasn’t
particularly strong at its inception, for example, neither the United States nor the Soviet
Union were founding members, but it slowly exerted influence on the international
chess scene, beginning with the creation of chess olympiads: popular team tournaments
played every two years.

In the 1920s an exciting new school of chess thought emerged. Called the hypermodern
school, the new theorists included Réti, Tartakower, and Nimzowitsch. They advocat-



nate the public. And programs like Chessmaster bring vast amounts of chess informa-
tion and instructional material to players, further promoting chess.

What Is Chess? 

We’ve traced the main developments in the history of chess without yet answering the
intriguing question, “What is chess?” Over the centuries, there have been many differ-
ent answers. It is a form of miniature warfare. It is a microcosm of class society. It is a
form of mental training. It is art. Science. Sport.

While it is rare that chess is described as merely a game, it certainly is a game.
Whatever else it may be seems to differ with the individual. It is a different adventure
for every player.

THE HISTORY OF CHESSMASTER

In 1986 The Software Toolworks developed the first
of a new generation of chess software for personal
computers, The Chessmaster 2000. An instant
classic, The Chessmaster 2000 broke new
ground by combining advanced artificial intel-
ligence with striking new user interface
concepts. Leapfrogging past traditional
flat chessboard representations, The
Chessmaster 2000 presented users
with a three-dimensional chess
board.  Numerous new features
allowed manipulation of the
chess-playing environment
allowing users to customize
their playing conditions. The
Chessmaster 2000 thus became
the standard by which chess
products would be judged.

Two years later, in 1988, The Software Toolworks stretched the boundary of chess pro-
gramming even further with the release of The Chessmaster 2100.  Smarter, stronger,
and with a new versatile mouse interface, The Chessmaster 2100 created an entirely
new playing environment. With the addition of the War Room, advanced players could
command their armies and at the same time watch their computer opponents calculate
endless responses. All the information about the game; captured pieces, move lists, com-
puter analysis were laid out under the direction of the player. 

In 1991, The Software Toolworks took another giant step forward with the release of The
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to the world championship more than once, but finally quali-
fied in 1972. His match against world champion Boris
Spassky was a world sensation, not only because of the
genius of Fischer’s play, but because of his demanding
antics at the beginning of the match. Almost pulling out,
he forfeited an early game and won the match after
starting out down by two games. A colorful anticommu-
nist, Fischer gave Western chess a huge boost. The chess
world experienced a great disappointment when, after
extensive negotiation with FIDE, Fischer refused to
defend his title in 1975. Karpov was named world cham-
pion by default. Fischer remained in self-imposed chess
exile for twenty years. When he reemerged in the early
1990s, it was to play (and win) a controversial rematch
against Spassky in war-torn Yugoslavia.

Late Twentieth-Century Flux

Chess today is as competitive as it has ever been.
World-class events support a sizable professional
class of chess players and the largest number of
hobbyist players in the history of the game.
Perhaps inevitable in such circumstances, the
world championship title has become the subject of controversy.
Currently two world chess organizations claim to have named a world champion. The
FIDE champion is Anatoly Karpov while the Professional Chessplayers Association
(PCA) sports Gary Kasparov. The latter player has emerged as a sophisticated and
articulate spokesperson for chess, often appearing on television to promote chess.
Reunification of the title is possible, particularly since the PCA has experienced some
loss of influence and financial support.

Nonetheless, chess today is
vibrant and exciting. Superstars
even include for the first time
women, such as the talented
Polgar sisters. Occasionally
players decry the advances of
computers, saying that it will
destroy human chess. Yet the
evidence is that advances in
computer technology have only
helped to advance chess.
Matches between grandmasters
and computers continue to fasci-



International Master Josh Waitzkin offered more of his insights with additional anno-
tated games. Bruce Pandolfini, noted chess author and Josh Waitzkin’s mentor, intro-
duced an all new approach to teaching with innovative move-by-move tutorials.
Chessmaster 6000 also featured a brand new, extremely powerful 300,000 game data-
base. Seizing the popularity of the Internet, Chessmaster 6000 formed an alliance with
Mplayer.com to create Chessmaster Live, the online component to Chessmaster. With
this alliance Chessmaster 6000 provided players with one-click access to free, live com-
petition over the Internet, 24 hours day.

And now Mindscape introduces Chessmaster 7000, the most comprehensive and pow-
erful Chessmaster yet. At the top of the list for 13 years in a row and with over 4 mil-
lion Chessmasters sold, Chessmaster hits another home run. Our newest version intro-
duces a whole new look and feel. Chessmaster’s rich feature set is arranged into differ-
ent rooms so that exploring is easier and more intuitive. The database has exploded to
500,000 games, there are even more human-like opponents and Josh Waitzkin annotat-
ed more of his best games. Kids now have a special place of their own. The Kids Room
offers a fun place where they can learn, compete and grow at their own pace.

Chessmaster continues to empower and challenge players young and old, beginner and
professional. With each version we are setting new milestones and creating an experi-
ence that makes Chessmaster the world’s most popular chess program.
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Chessmaster 3000. The watchword in the evolution of Chessmaster has always been cus-
tomization. With The Chessmaster 3000, users could take the control of the computer
thinking. In addition new pre-set “personalities”, players could modify how The
Chessmaster analyzed, how it valued individual pieces, how it evaluated positional
strength. Never before had any chess program given users this much versatility and power.

In 1993, The Software Toolworks reached the next stage in
computerized chess with the all-new Chessmaster 4000.
This world class program incorporated an all-new 32-bit
chess engine along with dazzling graphics, and modem and
networking capability.

In 1996, The Software Toolworks became
Mindscape and under this name the com-
pany developed and published
Chessmaster 5000. Chessmaster 5000 took
full advantage of the 32-bit capabilities of
Windows 95. A slick new look and a faster,
stronger, more versatile 32-bit Pentium-
optimized engine from TASC were only a
sample of the features that kept
Chessmaster at the top of the list of com-
puter chess programs. Chessmaster 5000
offered new chess players more than 20
tutorials that instructed them on the fine
points of chess tactics and strategy. The
tutorials were written by grandmasters
including GM John Nunn and GM Yasser
Seirawan. It also a database of  27,000 his-
toric chess games.

With the release of Chessmaster 5500 in
1997, the level of computer chess was taken
even higher.  The addition of several new
features made this version the most exciting
and compelling one to date. Mindscape
introduced Illustrated Voice Analysis (IVA), InfoVoice, and spoken commentary which
transformed Chessmaster into a virtual living presence as both instructor and oppo-
nent.  International Master Josh Waitzkin, subject of the book and movie “Searching for
Bobby Fischer®,” joinedthe Chessmaster team and provided in-depth spoken annota-
tion of some of his favorite games.

Chessmaster 6000 debuted in 1998. It featured an even stronger chess engine that took
it to #1 on the SSDF computer chess-rating list. Chessmaster 6000 provided players
with true-to-life opponents and the ability to develop their own chess rating.
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